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Chapter 1:

Introduction

This chapter introduces CyberLink PowerDirector and the digital video editing 
process. It provides a discussion of the different kinds of technology you will use 
in the digital movie-making process, as well as system requirements for working 
smoothly with CyberLink PowerDirector.

This chapter contains the following sections:

• "Welcome!" on page 2

• "The PowerDirector Program" on page 5

• "The Production Process" on page 7

• "System Requirements" on page 12
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Welcome!
Welcome to the CyberLink family of digital video tools. CyberLink 
PowerDirector is a digital video editing program that lets you create 
professional-looking video movies and photo slideshows, complete 
with music, voice-overs, special effects, transition effects and much 
more.

If you don’t have experience making movies or creating slideshows, 
don’t worry. CyberLink PowerDirector is an easy to use tool that, with 
just a little practice, will have you making movies like a Hollywood 
director. In no time you will be creating creative videos and stylish 
slideshows that you can email to friends, burn to disc to show your 
family, or upload to the Internet to share with the world.

Latest Features
This section describes the latest features in the CyberLink 
PowerDirector program.

Edit

• All new innovative way to create picture slideshows using the 
Slideshow Designer. 

• Includes the Auto Create Slideshow feature.

• Select from a variety of slide templates, including slides with 
multiple pictures on a slide. 

• Enhanced PiP Designer.
• Provides complete control for customizing the path of a PiP 

object as it moves across the video.

• New Magic Style.
• New flash animation elements like particle effects, alpha-

masked PiP and ending video to enhance the movie. 
• New Magic Designer for auto creation of video productions.
• Enhanced Magic Clean to instantly calibrate color to provide 

more vivid photo and video colors.
 2



Chapter 1: Introduction
• New and improved visual effects and titles, including the ability 
to add multiple effects to one video clip.

• Add objects and frames to your photos and videos.
• New add subtitles feature.

Produce

• Revolutionary Portable MPEG-4 AVC (H.264) Format for Apple 
iPod Video®.

• CyberLink PowerDirector is now equipped with the newly 
developed CyberLink H.264 codec. Now you can export 
your movie creation in MPEG-4 AVC (H.264) for Apple iPod 
Video®. 

• Revolutionary Portable MPEG-4 AVC (H.264) Format for Sony 
PSP®.

• CyberLink PowerDirector is now equipped with the newly 
developed CyberLink H.264 codec. Now you can export 
your movie creation in MPEG-4 AVC (H.264) to be stored on 
the Memory Stick and playback on Sony PSP®. 

• Direct YouTube® output and upload support.

• Automatically select the best output profile for YouTube®.

• CyberLink PowerDirector is the first YouTube® uploading 
application in the world for video bloggers to capture, edit, 
produce and upload videos to share with others. 

Other

• Design your own DVD templates.
• Users can use the template designer to fine-tune the 

existing templates, or create their own ones.

• Provide users a true 16:9 editing/authoring solution.

PowerDirector Versions
CyberLink PowerDirector is available in many different OEM versions 
and the full retail version. File format support, editing features, disc-
making functions, and other features vary depending on the version 
that you have. For information on the availability of specific functions in 
3



CyberLink PowerDirector 6
the CyberLink PowerDirector version that you are using, please check 
the CyberLink PowerDirector Readme file.

Upgrade Your Software
Software upgrades may be periodically available from CyberLink. To 
upgrade your software, click the Upgrade button on the About 
CyberLink PowerDirector window. The Upgrade window will open and 
you can select to download new upgrades and patches. You will be 
redirected to CyberLink’s cyberstore if you choose to purchase new 
upgrades.

Note: You must be connected to the Internet to use this feature.
 4



Chapter 1: Introduction
The PowerDirector Program
When you first open CyberLink PowerDirector, the program appears as 
follows:

Library window
Contains your media content as well as various 
effects, transitions and other media rooms

Mode buttons
Click to switch working 
modes

Function buttons
Shortcuts to common functions

Workspace
Insert media clips and effects 
here

Preview window
Provides playback controls to preview 
clips and movies

Edit function buttons
Open editing rooms dedicated to a 
specific task

Magic Tools
Provide easy ways to work with 
media clips
5
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PowerDirector Modes
CyberLink PowerDirector has separate modes that enable you to 
perform different tasks: Capture, Edit, Produce and Create Disc.

By default, CyberLink PowerDirector opens in the Edit mode, but you 
can easily switch between modes to perform your required task by 
using these buttons.

PowerDirector Projects
Changes you make to your video clips, audio files or photos in 
CyberLink PowerDirector do not affect your original media. Since your 
settings are all saved in the project file, you can trim, edit or delete clips 
in CyberLink PowerDirector, but still keep your original files on your 
hard drive, untouched. So let yourself get creative! If you end up 
changing things too drastically, you can always start over.

You can open and save a CyberLink PowerDirector project file just like 
any other file in Windows. Your projects are saved as .pds files, a unique 
file format used by the CyberLink PowerDirector program.

Mode Description

Capture media in a variety of formats, from a 
variety of sources. See "Capturing Media" on page 
18.

Edit your production by adding video and photos 
to the timeline, then add transitions, effects and 
titles for that creative touch. See "Creating Your 
Story" on page 65.

Produce your creation by outputting it to a file, DV 
tape or uploading to the Internet. See "Producing 
Your Movie" on page 169.

Use Create Disc to create a custom disc, complete 
with menus, that can be burnt to disc. See "Creating 
Discs" on page 211.
 6



Chapter 1: Introduction
The Production Process
The digital production process involves a combination of artistry and 
technology, beginning with raw footage and ending with your final 
production. CyberLink PowerDirector is the easiest way to produce your 
finished movie or photo slideshow and publish it to the medium of your 
choice.

The production process, depending on your purpose, may involve 
some or all of the following phases:

• Pre-production
• Importing your media
• Capturing your media

• Detecting scenes and extracting audio
• Putting your story together

• Adding your media to the workspace
• Adding effects, transitions and titles

• Editing and refining your videos
• Touching up your photos
• Using Magic Tools and modifying effects

• Recording voice overs and mixing audio
• Setting chapters and adding subtitles

• Producing and Uploading Your Productions
• Producing video files

• Producing streaming video files
• Writing back to a DV tape

• Uploading to the Internet
• Finalizing production to discs

• Creating disc menus
• Burning your productions to disc
7
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Pre-Production
Before you can begin creating your final production, you should first 
collect all of your media content. After you have shot your video, taken 
all your photos, gathered all your music, then you are ready to begin 
working on your production by importing and capturing your media in 
CyberLink PowerDirector.

Importing Your Media
If you already have some or all of your content on your computer, it is 
recommended that you place it all in one folder so that the entire folder 
can be quickly imported into the Media Library. If this is not the case, 
you may also import individual media files as well at any time.

Capturing Your Media
If your media content is not yet on your computer, you can use 
CyberLink PowerDirector to capture it and then directly import it into 
the Media Library. 

CyberLink PowerDirector allows you to:

• Capture from DV Camcorder  
• Capture from HDV Camcorder 
• Capture from TV 
• Capture from Digital TV 
• Capture from PC Camera 
• Capture from Microphone 
• Capture Audio Tracks from CD 
• Capture from a DVD 

Detecting Scenes and Extracting Audio
With CyberLink PowerDirector, you can add additional video clips and 
audio to your Media Library by using the detect scene and extract 
audio functions on your video files. Performing these functions before 
you get started can save you time during the editing process.
 8
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Putting Your Story Together
Now that you have all of your content ready, this is when the fun part 
begins and you can get as creative as you want. You can spend hours 
fine tuning your production or use the guided wizards and designers to 
quickly assist you to finish your creation.

Adding Media to the Workspace
CyberLink PowerDirector lets you add and combine video, photos, 
music, video effects, objects, titles and transitions to your project in the 
workspace. You can also use the Magic Move Wizard or the Slideshow 
Designer for assistance if you are in hurry or not sure how to start.

Editing and Refining Your Media
Once you have all your content, you may need to refine it by editing out 
parts of a video you don’t want, touching up your photos or use the 
Magic Tools to fix shaky video or clean up video and audio. 

Here are just a few editing functions you can perform with CyberLink 
PowerDirector:

• split video clips
• trim video and audio files
• change the speed or aspect ratio of a video clip
• change the color of a visual media clip
• edit your photos in PhotoNow!

You may also use any of CyberLink PowerDirector’s Magic Tools to 
quickly and easily adjust your content to the exact way you want it. 
CyberLink PowerDirector’s Magic Tools make working with audio, video 
and image clips easier than ever before. 

Recording Voice Overs and Mixing Audio
Your production’s audio can make or break your creation. With 
CyberLink PowerDirector there are several options to enhance the 
9
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audio portion of your production to create the ultimate finalized 
product.

In the Voice-Over Recording Room you can record a narration with a 
microphone while watching the video clip the voice-over is destined to 
accompany. When you capture your narration, the audio track is 
synchronized with the video portion.

Once you have all of your audio files, step into the Audio Mixing Room 
to fine tune the levels of all your audio to ensure it is perfect.

Setting Chapters and Subtitles
Once your production is near completion you can add chapters for easy 
navigation if your production is destined to be burned to disc or add 
subtitles to your movie.

The Set Chapter Room contains options for automatically or manually 
setting chapter markers. Setting chapters on your final disc allows 
viewers to jump from the menu page to the chapter markers you have 
set in order to navigate around your disc.

In the Subtitle Room you can add subtitles for language assistance or to 
add comments that will be shown during your movie production.

Producing and Uploading Your 
Productions

After editing your media and creating your movie, it’s time to produce 
your project. You can choose to create a movie file for playback on your 
computer, create a streaming file for use on the Internet, write your 
movie back to DV tape or upload your production directly to YouTube 
or MediaMax. In just a few simple steps, your production will be 
finalized and ready for viewing.
 10
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Finalizing Your Production Disc
With CyberLink PowerDirector you can put finishing touches on your 
production by creating a disc that can be viewed on any DVD player.

Authoring disc menus
Use the Menu Designer to create a professional looking discs, complete 
with professional looking menus, background music, stylish buttons, 
video thumbnails and much more.

Burning your production to disc
Burn your creation to disc directly within CyberLink PowerDirector or 
create a DVD folder that can be burned at a later date.
11
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System Requirements
The system requirements listed below are recommended as minimums 
for general digital video production work.

Screen Resolution:

• 1024 x 768, 16-bit color or higher

OS:

• Windows Vista/XP/2000 (Windows XP Service Pack 2 is required 
for HDV capture)

Memory:

• 256 MB required (512+ MB DDR recommended)
• 1 GB DDR2 Ram recommended for HD content editing

CPU:

• Capture/produce AVI: Pentium 2-450 MHz or AMD Athlon 500 
MHz

• Capture/produce VCD Quality (MPEG-1): Pentium 3-600 MHz 
or AMD Athlon 700 MHz

• Capture/produce DVD Quality (MPEG-2): Pentium 4-2.2 GHz or 
AMD Athlon XP 2200+

• Capture/produce High Quality MPEG-4 and Streaming Videos 
(WMV, QuickTime, RealVideo, DivX): Pentium 4 2.4 Ghz or AMD 
Athlon XP 2400+

• Produce MPEG-4 AVC and MPEG-2 HD Files: Pentium 4 3.0 Ghz 
with HyperThreading or AMD Athlon 64 recommended

• Edit HD Contents: Pentium 4 3.0 Ghz Duel Core CPU 
recommended

• CyberLink PowerDirector 6 is optimized for CPU with MMX/SSE/
SSE2/3DNow!/3DNow! Extension/HyperThreading technology

• CyberLink PowerDirector 6 editing engine is optimized for Intel 
Duel Core CPU.

Video Capturing Device:
 12



Chapter 1: Introduction
• PCI or USB1.0/2.0 capture device compliant with WDM standard 
(i.e. PC Camera and TV tuner with WDM driver)

• DV camcorder connected via OHCI-compliant IEEE1394
• DVD camcorder connected via USB2.0
• Sony MicroMV camcorder
• JVC Everio camcorder (GZ-MC100, GZ-MC200)
• Sony HDR-FX1 (HDV)
• Sony HDR-HC1 (HDV)
• Sony HDR-HC3 (HDV) 
• JVC GR-HD1U (HDV)

Hard Disk Space:

• 5 GB required (400MB for SmartSound Quicktrack Library)
• 10 GB (15 GB recommended) required for DVD production
• 100 GB (7200 rpm) recommended for HD content editing

CD/DVD Burning Device:

• CD/DVD burner (CD-R/RW, DVD+R/RW or DVD-R/RW) is required 
to burn VCD/DVD/SVCD titles

Microphone:

• A microphone is required for recording voice-overs.

Note: Please consult the CyberLink web site for the most recent system 
requirements information. http://www.cyberlink.com/
13
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Pre-production

This chapter details the steps required for pre-production, including importing 
your media into the Media Library, capturing media with CyberLink 
PowerDirector and setting your CyberLink PowerDirector preferences.

This chapter contains the following sections:

• "Importing Media" on page 16

• "Capturing Media" on page 18

• "Detecting Scenes and Extracting Audio" on page 50

• "PowerDirector Preferences" on page 54
15
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Importing Media
If you already have video files, music and photos on your computer’s 
hard drive that you want to use in your production you can import 
them directly into CyberLink PowerDirector’s Media Library.

CyberLink PowerDirector supports the import of the following file 
formats:

Image: JPEG, TIFF, BMP, GIF, PNG

Video: HD MPEG-2, DVR-MS, DV-AVI, DAT, MPEG-1, MPEG-2, VOB, VRO, 
WMV, WMV-HD, MOV, MOD, DivX, MP4

Audio: MP3, WAV, WMA, ASF 

When importing media into the Media Library, you have two options: 

• import media files individually
• import an entire folder that contains media files you want to use 

in your current project.

Import Individual Media Files
To import individual media files into the Media Room Library, do this:

1. Click  to open the Media Room.

2. Select the type of media you want to import (or All Media) from 
the Filter drop-down list.

Note: By selecting a media type (other than All Media) in this drop-down 
list, you restrict the type of media displayed in the Library, and consequently, 
the type of media that you can import.

3. Click  and select Import Media File(s). A dialog box 
opens.

4. Locate and open the file(s) you want to add. Thumbnails of each 
media file you have selected appears in the Media Library.
 16



Chapter 2: Pre-production
Import a Media Folder
To import all of the media files in a particular folder, do this:

1. Click  to open the Media Room.

2. Click  and select Import a Media Folder. A dialog box 
opens.

3. Locate the folder you want to open, then click OK. All of the media 
files in that folder are loaded into the Media Library.

Note: If you feel there are too many files in your Media Library, you can 
remove them from the library without removing them from your computer’s 
hard drive. See "Remove a Clip from the Library" on page 73 for more 
information.
17
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Capturing Media
CyberLink PowerDirector lets you capture media from a variety of 
sources directly into your Media Library.

Capture Mode

When you click the  button you will enter the Capture 
mode. In Capture mode, the program appears as follows: 

Information display area
Displays information about captured file 
size and available HDD space

Captured clips area
Displays media clips after capture

Capture preview window
Displays media clips during capture

Capture device selection area
Allows you to switch capture devices
 18



Chapter 2: Pre-production
Note: Before you begin to capture, make sure your capture environment is 
set according to your preferred working methods. See "Capture Preferences" 
on page 61 for more information.

Capture Options
You can capture video clips in the following file formats:

• MPEG-1
• MPEG-2
• MPEG-4
• AVI
• DivX

To select the file format of your captured video clip, see "Profile Options 
for Video Clips" on page 20. 

Many of the options for capturing are the same for some of the capture 
modes. These options are described below, but not all of the options 
described in this section are available in all capture modes. Descriptions 
of options specific to a capture mode are found in the section that 
describes it.

Note: CyberLink PowerDirector’s capture functions vary, depending on 
version installed. For information on the availability of specific features in the 
version that you are using, please check the Readme file.

Capture Limit Options
You can set limits on the size or duration of the video that CyberLink 
PowerDirector captures. When the limit you set is reached, the capture 
will automatically stop.
19
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• To set a maximum capture length, check Time limit, then enter a 
time in the timecode box.

• To set a maximum captured file size, check Size limit, then enter 
a size limit (in MB).

The Text Captions button  lets you add a text caption, date caption 
or time code to captured video. See "Add Text Captions" on page 48 for 
information on using this feature.

The Snapshot button  lets you take a still photo of the video you 
are watching. Just click on the Snapshot button at a point where you 
want to take a snapshot and an image file will be saved to the Media 
Library.

Note: You can specify your preferred snapshot image file format in 
preferences. See "File Preferences" on page 54 for detailed information.

Profile Options for Video Clips
When capturing a video clip you can select its file format as well as 
configure the profile for the file format.

To set the profile file format, do this:

1. Click Profile. The Profile Setup dialog box opens.

2. Select the desired file format of the captured file from the first 
drop down list.

3. Set the file format profile as follows:
 20
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• To set the profile for a MPEG-1 Video file, see "Create a New 
MPEG-1 Profile" on page 178.

• To set the profile for a MPEG-2 Video file, see "Create a New 
MPEG-2 Profile" on page 181.

• To set the profile for a WIndows AVI file, see "Modify 
Windows AVI Profile Settings" on page 175.

• To set the profile for a DivX file, see "Modify DivX Profile 
Settings" on page 177.

4. Click the Comments and Details buttons for more information 
about the profile.

5. Click on the OK button to save the profile settings.

Video Capture Options
Click Settings. The Video Settings dialog box opens, displaying the 
Video Setup tab. You may select your capture source here for either 
Analog or Digital video capture (i.e. depending on the capture mode 
selected). You can also select your video’s audio input device, audio 
input source, set the input volume here control and access the 
Windows Audio Mixer
21
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Click the Adjust Video tab to adjust the video picture display options, if 
necessary.

Click the TV Setup tab to select your television signal format by 
selecting your location. You may also setup your audio format, if 
necessary.
 22
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CD/Microphone Capture Profile Setup
When recording from a CD or microphone, click Profile to set up your 
CD or microphone recording profile. You may select an audio quality 
here. 

• You can save a profile using a unique name by clicking the Save 
As... button. Click Remove to remove the new profiles you 
create.

Audio Capture Options
Before you capture from a microphone, there are several options you 
can configure.

• Drag the volume level slider to set the input volume level.
• Check Begin with fade-in to start an audio capture in with a 

fade-in from silence.
23
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• Check End with fade-out to end an audio capture with a fade-
out to silence.

Click Settings to open the Audio Setup dialog box. You may select your 
audio input device, audio input source, and input volume here.

PC Camera Capture Options
When capturing from a PC camera, click Settings to set up your capture 
profile. On the Video Setup tab you can select your capture source and 
select the PC camera’s audio input device, audio input source and input 
volume. Click Advanced Settings for more options.
 24
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Note: Advanced settings may differ depending on the PC camera you are 
using. Please refer to your PC camera’s user guide to configure the advanced 
settings for it.

Captured Clip Options
After you capture clips, a number of options are available for managing 
them. Some of these options appear in the dialog box immediately 
after capture, while others are available in the Captured Clips area of 
the Capture window.

• Click Change Folder to set a different destination folder for 
captured clips.

Note: You should set this option before capturing clips.

Post-Capture Options
To delete a captured file, click Delete in the dialog box that appears 
after recording.

To name a captured file, enter a name in the dialog box that appears 
after recording. To have CyberLink PowerDirector automatically save 
and name captured files, check the Don't prompt me to confirm file 
name option in the dialog box that appears after recording.

Note: You may set the auto naming prefix or re-enable the file naming 
prompt in File Preferences. See "File Preferences" on page 54 for more 
information.
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Captured Clips Area Options
Video, audio and photos you capture appear in the Captured Clips area. 
Right-clicking clips in this area displays a menu that provides several 
options:

• Play in Media Viewer: Select this option to view the clip in the 
Media Viewer. See "Preview a Clip in the Media Viewer" on page 
98.

• Detect Scenes: Select this option to detect the scenes contained 
in a video clip. See "Detect Scenes in a Video Clip" on page 50.

• Remove Item: Select this option to remove the clip from the 
Captured Clips area.

• Delete from Disk: Select this option to remove the clip from the 
Captured Clips area and delete the source file from your hard 
disk.
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Capture from DV Camcorder
DV camcorders are popular among video hobbyists, as they record in a 
digital format that does not require conversion before being used on a 
computer, and often provide a number of advanced recording options. 
You can capture a single scene or a number of scenes in a batch from 
your camcorder. Procedures for both methods are described below.

Capture a Single Scene
You can capture a single segment of video from your camcorder. This 
function is particularly useful, for example, if you want to acquire a long 
video segment in its entirety without skipping over sections.

To capture a single scene from a DV camcorder, do this:

Note: Make sure your camcorder is in VCR mode before capturing.

1. Click  to open Capture mode.
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2. Click  to open the DV camcorder capture function. (You may 
have to wait a few moments as CyberLink PowerDirector switches 
capture modes.)

3. Locate the position where you would like to begin capturing. You 
may do this in one of the following ways:

• Use the playback buttons.
• Enter a timecode, then press the Enter key on your 

keyboard seek to that timecode.

• Drag the time slider . 

4. Set your capture options (if necessary). See "Capture Options" on 
page 19.

• Check Non-realtime to continue processing captured video 
after the original video stops playing in order to ensure that 
no frames are dropped. Capturing video at a higher speed 
reduces processing time, but yields video of a lower quality. 
Capturing better quality video requires more CPU power 
and more time to complete.
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5. Click  to begin capture. The video plays in the preview window 
as you capture.

6. Click  to stop capture before completion. The clip you have 
captured will appear in the Captured Clips area.

DV Backup
The DV Backup feature lets you back-up the digital video from your DV 
camcorder directly to DVD using CyberLink PowerDirector.

Note: This feature requires a DVD burner.

To backup digital video from a DV camcorder, do this:

1. Click  to open Capture mode.

2. Click  to open the DV device capture function. (You may have 

to wait a few moments as CyberLink PowerDirector switches 
capture modes.)
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3. Click . The DV Backup dialog box opens.

4. Select the DV camcorder from the drop-down you would like to 
backup if more than one is attached.

5. Select the burning drive from the Select backup destination 
drop-down.

6. Click the Option button to configure the following burning 
configuration options:

• Select a recording speed.
• The Include buffer under-run protection option ensures 

that your drive writes without errors when your hard drive is 
busy or system resources are low.

7. In the Set backup time drop-down, select whether to:

• backup the entire contents of the DV tape that is currently 
in your DV camcorder.

• backup from the current position on the tape to the end of 
the tape.

• backup a specified amount of time (in minutes) from the 
current position.

8. Set the backup profile for the DV video. See "Profile Options for 
Video Clips" on page 20 for more information on setting profiles 
for MPEG-2 files.
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9. Enter a disc name for your disc in the Disc volume label field.
10. Locate the position where you would like to begin backing up 

your DV video (if you do not want to backup the entire DV tape). 
You may do this in one of the following ways:

• Use the playback buttons.

• Enter a timecode, then click  to seek to that timecode.

• Drag the time slider .

11. Click on the Start button. CyberLink PowerDirector will proceed to 
backup your DV camcorder video. A message will be displayed 
once the backup is complete.

Batch Capture from a DV Camcorder
Batch capturing may seem intimidating, but in reality it is an incredibly 
convenient method of capturing multiple video clips automatically. If 
you take a few minutes to familiarize yourself with batch capturing, you 
will save yourself time when you capture video from your camcorder. 
CyberLink PowerDirector scans your DV for intervals (or allows you to 
set them manually), then captures them in a batch using the intervals 
you created.

Automatic Batch Capture
Automatic batch capture is a quick way to capture scenes from a video 
tape.

To perform an automatic batch capture, do this:

Note: Make sure your camcorder is in VCR mode before capturing.

1. Click  to open Capture mode.
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2. Click  to open the DV device capture function. (You may have 

to wait a few moments as CyberLink PowerDirector switches 
capture modes.)

3. Set your capture options (if necessary). See "Capture Options" on 
page 19.

• Check Non-realtime to continue processing captured video 
after the original video stops playing in order to ensure that 
no frames are dropped.
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4. Click . The DV QuickScan dialog box opens.

• Click Note for important information on how to use the DV 
QuickScan function.

5. Locate the position where you would like to begin scanning for 
intervals. You may do this in one of the following ways:

• Use the playback buttons.

• Enter a timecode, then click  to seek to that timecode.

• Drag the time slider .

6. Click Start to start scanning for intervals. CyberLink PowerDirector 
scans for intervals. 
33



CyberLink PowerDirector 6
7. Click Stop after all of the video segments you want to capture 
have been scanned. Scanned intervals appear as thumbnails in the 
window.

• Click Back to return to the QuickScan function.

8. Check the thumbnails of the intervals you want to batch capture.
• You can change the profile of the clips to be captured. To do 

this, click Profile and select a new profile.
• To combine sequential intervals into a single interval, check 

the intervals, then click Merge. Click AutoMerge to 
combine all checked intervals in sequence or to merge all of 
the clips in an interval that you can set.

9. Click Start to begin batch capture. CyberLink PowerDirector 
rewinds your tape to the position of the first clip, then begins 
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capturing all of the intervals you have checked. The video plays in 
the preview window as you capture. The clips you have captured 
appear in the Captured Clips area.

• Click Stop to if you want to stop the capture process.

10. Click Finished to return to Capture mode.

Manual Batch Capture
Using manual batch capture gives you more control over the capturing 
process and ensures that the scenes you want to include are captured. 
Manual batch capturing is recommended when you are sure which 
scenes you want to capture and have a good idea where they are 
located on the tape.

To perform a manual batch capture, do this:

Note: Make sure your camcorder is in VCR mode before capturing.

1. Click  to open Capture mode.
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2. Click  to open the DV device capture function. (You may have 
to wait a few moments as CyberLink PowerDirector switches 
capture modes.)

3. Set your capture options (if necessary). See "Capture Options" on 
page 19.

• Check Non-realtime to continue processing captured video 
after the original video stops playing in order to ensure that 
no frames are dropped.
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4. Click . The DV Manual Scan/Batch Capture dialog box 
opens.

5. Click .

6. Navigate to the mark in time by doing one of the following:
• Use the playback buttons.

• Enter a timecode, then click  to seek to that timecode.

• Drag the time slider .

7. Click  to set the mark in point.

8. Navigate to the mark out time, then click  to set the mark out 
point. The intervals you set appear in the pane to the right of the 
preview window.

Note: You can continue to set intervals of clips to capture. Each interval, 
however, must have a duration of at least two frames.

9. Click Start to begin batch capture. CyberLink PowerDirector 
rewinds your tape to the position of the first clip, then begins 
capturing all of the intervals you have checked. The video plays in 
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the preview window as you capture. The clips you have captured 
appear in the Captured Clips area.

• Click Stop if you want to stop the capture process.

• Click Add to start another round of batch capturing.
10. Click Finished to return to Capture mode.

Capture from HDV Camcorder
HDV camcorders record in a high definition digital format that does not 
require conversion before being used on a computer, and often provide 
a number of advanced recording options. You can capture scenes from 
your HDV camcorder into CyberLink PowerDirector. The procedure is 
described below.

To capture a single scene from a HDV camcorder, do this:

Note: Make sure your camcorder is in VCR mode before capturing.

1. Click  to open Capture mode.
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2. Click  to open the HDV camcorder capture function. (You 
may have to wait a few moments as CyberLink PowerDirector 
switches capture modes.)

3. Locate the position where you would like to begin capturing. You 
may do this in one of the following ways:

• Use the playback buttons.

• Enter a timecode, then click  to seek to that timecode.

• Drag the time slider .

4. Set your capture options (if necessary). See "Capture Options" on 
page 19.

5. Click  to begin capture. The video plays in the preview window 
as you capture.

6. Click  to stop capture before completion. The clip you have 
captured will appear in the Captured Clips area.
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Capture from TV
You may wish to add segments from your favorite TV programs to your 
movie production, or simply record other segments for different uses.

To capture from a TV, do this:

1. Click  to open Capture mode.

2. Click  to open the TV capture function. (You may have to wait 
a few moments as CyberLink PowerDirector switches capture 
modes.)

3. Set your capture options (if necessary).

• Click  to choose CATV or Antenna.

4. Locate the channel you want to capture. You may do this in one of 
the following ways:

• Click  to go up a channel or  to go down a channel.
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• Click  to return to the previous channel.
• Enter a channel number in the channel box.

5. Click  to begin capture.

6. Click  to stop capture. The clip you have captured will appear 
in the Captured Clips area.

Capture from Digital TV
You may wish to add segments from your favorite Digital TV programs 
to your movie production, or simply record other segments for different 
uses.

To capture from Digital TV, do this:

1. Click  to open Capture mode.
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2. Click  to open the Digital TV capture function. (You may have 
to wait a few moments as CyberLink PowerDirector switches 
capture modes.)

3. Set your capture options (if necessary).

• Click  if you have not yet setup your digital TV channels.

4. Locate the channel you want to capture. You may do this in one of 
the following ways:

• Click  to go up a channel or  to go down a channel.

• Click  to return to the previous channel.
• Enter a channel number in the channel box.

5. Click  to begin capture.

6. Click  to stop capture. The clip you have captured will appear 
in the Captured Clips area.
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Capture from PC Camera
PC cameras (also known as web cams) are inexpensive, handy video 
cameras that you can use for simple video capturing.

To capture from a PC camera, do this:

1. Click  to open Capture mode.

2. Click  to open the PC camera capture function. (You may have 
to wait a few moments as CyberLink PowerDirector switches 
capture modes.)

3. Set your capture options (if necessary). See "Capture Options" on 
page 19.

4. Click  to begin capture.

5. Click  to stop capture. The clip you capture will appear in the 
Captured Clips area.
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Capture from Microphone
Your movie may require recorded dialog. No matter what kind of audio 
tracks you record, they can be captured with a microphone for use in 
your CyberLink PowerDirector project.

To capture from a PC microphone, do this:

1. Click  to open Capture mode.

2. Click  to open the microphone capture function. (You may 
have to wait a few moments as CyberLink PowerDirector switches 
capture modes.)

3. Set your capture options (if necessary). See "Capture Options" on 
page 19.

4. Click  to begin capture. Recording begins after a three-second 
countdown.

5. Click  to stop capture. The clip you capture will appear in the 
Captured Clips area.
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Capture Audio Tracks from CD
Using your favorite music can help you to create a really fun, 
personalized movie. If you have music stored on an audio CD, you can 
record songs you want and then add them as audio tracks in your 
CyberLink PowerDirector project.

To record audio tracks from a CD, do this:

1. Click  to open Capture mode.

2. Click  to open the CD capture function. (You may have to wait 
a few moments as CyberLink PowerDirector switches capture 
modes.)

3. Select the disc drive where the CD was inserted. 
4. Select the track you want to record from the drop-down list. You 

may preview the track if required by using the player controls.

5. Set your capture options (if necessary). See "Capture Options" on 
page 19. Select Record at maximum speed to record the audio at 
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a higher speed. Capturing at a higher speed reduces processing 
time, but yields audio of a lower quality.

6. Click  to begin capture. 

7. The entire track will be recorded automatically or click  to stop 
capture to record just an excerpt of the song. The audio clip you 
capture will appear in the Captured Clips area.

Capture from a DVD
You can capture video scenes (including the audio portion) from a DVD 
for use in your CyberLink PowerDirector project.

Note: Some DVDs are protected by technology that does not allow you to 
capture the content they contain.

To capture scenes from a DVD, do this:

1. Click  to open Capture mode.
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2. Click  to open the DVD capture function. (You may have to 
wait a few moments as CyberLink PowerDirector switches capture 
modes.)

3. Select the disc drive where the DVD was inserted by clicking DVD 
Drive button.

4. Use the DVD disc navigation tree on the left to select the chapters. 
or titles you want to capture. You may preview the DVD if required 
by using the player controls.

5. Set your capture options (if necessary). See "Capture Options" on 
page 19.

6. Click  to begin capture. 

7. The entire selected chapter/content will be captured 
automatically and then appear in the Captured Clips area.
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Add Text Captions
You may add captions to the DV/TV media clips that you capture, 
including a date code, time code or a short remark.

Note: Text captions are different from subtitles. If you would like to add 
subtitles to your video, see "Chapters" on page 163.

To set your text captions options, go to the TV capture function or DV 

capture function and click .

The Add text overlay on captured video dialog box opens, displaying 
the Overlay Text tab.

 Available options are as follows:

• Add Date Code: Check this option to add a date code on your 
captured video. Select a date code format that best fits your 
need.

• Add Time Code: Check this option to add a time code on your 
captured video. Select a time code format that best fits your 
need.

• Add Remark: Check this option to add a remark on your 
captured video.

Click the Overlay Format tab. Available options are as follows:

• Font Type: Set the font type for your text captions.
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• Font Size: Set the font size and color for your text captions.
• Text Order: Set the order of the text captions.

Text Position: Set the position where you want the captions to appear 
in your video by clicking and dragging it to the desired position.

Take a Still Snapshot of a Video Clip
You can capture a single frame from a video clip or capture device and 
automatically load the snapshot into the Media Library.

Snapshots can be captured in the following ways: 

• in Capture Mode, clicking  during the playing of live TV, live 
Digital TV, a DV camcorder, an HDV camcorder or a PC web cam.

• in Edit Mode, selecting a video clip in the Media Library and 

clicking  on the Preview Window.

• in Edit Mode, clicking  during the playback of a video clip in 
the Preview Window.

Note: You can specify your preferred snapshot image file format in 
preferences. See "File Preferences" on page 54 for detailed information.
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Detecting Scenes and 
Extracting Audio

To assist with your editing process, CyberLink PowerDirector can detect 
scenes in your video clips or extract the audio from them, and have 
these new clips displayed separately in the Media Library.

Detect Scenes in a Video Clip
The scene detection function automatically creates individual clips 
based on the individual scenes (or pre-edited shots) contained within a 
video clip. Detected scenes are not split from the original clip, but can 
be added to the workspace like any other media clip. Likewise, they 
may also be merged together or removed entirely without changing 
the original video clip.

You can detect scenes in a video clip in both the Captured Clips area or 
within the Media Library.

To detect scenes in a video clip, do this:

1. Right click the video clip whose scenes you want to detect and 
select Detect Scenes or select the video clip whose scenes you 

want to detect in the Media Library and click .
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2. The Scene Detection window opens.

3. Increase or decrease scene detection sensitivity, if necessary. 
Increased or decreased scene detection sensitivity yields an 
increased or decreased number of scenes that are detected. You 
may do this in one of the following ways:

• Drag the Sensitivity slider.

• Click the  or  buttons.

4. Click Settings and set your scene detection options, if necessary:
• The Detection method section pertains to video clips that 

have been captured. (If the video clip was not captured, the 
Detection Method options are disabled.) If you have a DV 
AVI clip that contains multiple time codes (i.e.: time codes 
are automatically set when you start and stop recording) 
and you wish to split up your clip in this manner, select 
Detect by changing of timecodes. Otherwise, use Detect 
by changing of video frames.

5. Locate the position where you would like to begin detecting 
scenes. You may do this in one of the following ways:

• Use the playback buttons.
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• Drag the time slider.
• Enter a timecode.

6. Click Detect. The scenes in the video clip will be detected and then 
displayed in the content window.

• To set scenes manually, click Split instead of Detect.
• To stop the scene detection process before completion, 

click Stop or press the <Esc> key.

• After the original scene detection, you may further detect 
scenes within a newly generated scene. To detect scenes 
manually (including changing detection sensitivity), select a 
scene, then repeat the steps for detecting scenes. To detect 
scenes automatically, right-click a scene and select Detect 
Again from this scene.

• To remove a scene after detection, right-click the scene and 
select Remove Scene.

7. Click  to close the Scene Detection window.

•  To return to the Library, click .

The detected clips are displayed in a sub folder under the original video 
clip. They can be added to the workspace and managed in the Media 
Library like any other video clip.

Video clips that contain detected scenes show a small folder icon in the 
lower right-hand corner of the clip when displayed in the Media Library. 
To display a clip’s scenes, click the folder icon.
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Extracting Audio from a Video Clip
If you want to include just the audio from a video clip, you can extract it 
from video clips in the Media Library. The audio clip will be separated 
from the video and can be used in your project like any other audio file.

To extract audio from a video clip, do this:

1. Right click on a video clip in the Media Library that contains the 
audio want to extract and select Extract Audio.

2. The Save As Windows dialog box is displayed.

3. Browse to the folder location where you want to save the audio 
file, enter a file name for it and then click on the Save button. The 
audio portion of the video will be extracted and saved as a .wav 
file in your Media Library.
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PowerDirector Preferences
CyberLink PowerDirector offers a range of choices to set your video 
production environment to better suit the way you work. Before you 
get started working on your production you may want to set your 
preferences to your liking. You may also edit them at any time during 
the production process to accommodate your needs.

File Preferences
To set your file preferences, click Edit > Preferences... The Preferences 
dialog box opens, displaying the File tab. Available options are as 
follows:
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• Import directory: Set the folder where CyberLink PowerDirector 
looks by default for media clips when you load media files. To 
change this folder, click Browse and select a new folder.

• Export directory: Set the folder where CyberLink PowerDirector 
saves captured media files by default. To change this folder, click 
Browse and select a new folder.

• Captured video prefix: Enter a default name for captured video 
files. CyberLink PowerDirector automatically appends a 
sequential number to this name to create a unique filename for 
each captured file.

• Always prompt me to confirm filename: Check this option if 
you would like CyberLink PowerDirector to prompt you to enter 
a filename each time you capture a video clip.

• Production file prefix: Enter a default name for files produced in 
CyberLink PowerDirector.

• Snapshot filename: Enter a default name for snapshot captures. 
CyberLink PowerDirector automatically appends a sequential 
number to this name to create a unique filename for each 
captured file. Select a file format from the drop-down list for your 
snapshots. You have the choice between .bmp, .jpg and .gif 
formats.

• Always prompt me to confirm filename: Check this option if 
you would like CyberLink PowerDirector to prompt you to enter 
a filename each time you take a snapshot.

• Snapshot destination: Select a destination for snapshot 
captures from the drop-down list if you don’t want to save them 
as a file.

• Use master video size whenever possible: Select this to have 
the snapshot be the same size as the original video, instead of 
the smaller preview window it was taken in. 

• Number of recently used file projects: Enter a number 
(between 0 and 20) of recently used files that you would like to 
make available in the File menu when you open CyberLink 
PowerDirector.

• Automatically load the most recent project when 
PowerDirector opens: Check this option to automatically load 
55



CyberLink PowerDirector 6
the project you have been working on most recently whenever 
you open CyberLink PowerDirector.

General Preferences
To set your general preferences, click Edit > Preferences... The 
Preferences dialog box opens. Click the General tab. Available options 
are as follows:

• Maximum undo levels: Enter a number (between 0 and 100) of 
levels of undo you would like to make available while you work 
on your movie production. Setting a higher number of undo 
consumes more CPU resources.
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• TV format: Select the TV format (NTSC or PAL) of the region in 
which you would like to produce your movie. This format should 
correspond to the format of the region in which you plan to play 
your movie (if you burn it to disc).

• Enable animated Interface: Check to enable the animated 
interface within CyberLink PowerDirector.

• Show sound waveform in Timeline: Check to display the sound 
waveform in the timeline that represents the sound levels in the 
audio portion of video clips, music clips and voice clips.

• Enable file processing to speed up the editing of high 
definition video: Select this to speed up the editing of high 
definition video by enabling CyberLink PowerDirector to process 
the file faster. Enabling this consumes more CPU resources.

• Allow program to append information into files as RichVideo 
information: Check to allow CyberLink PowerDirector to append 
RichVideo information into the media files.

• Enable RichVideo information in open media dialog: Check to 
allow RichVideo information to be displayed in open media 
dialog.

• Automatically connect to the Internet to check for new 
software updates: Check to automatically connect to the 
Internet to check for new software updates for CyberLink 
PowerDirector.

• Use system default language: Select this option for the 
CyberLink PowerDirector language display to be the same as the 
default language of your operating system.

• User defined: Select this option and then select the language 
from the drop-down list that you want CyberLink PowerDirector 
to use.
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Editing Preferences
To set your editing preferences, click Edit > Preferences... The 
Preferences dialog box opens. Click the Edit tab. Available options are 
as follows:

• Default workspace: Select to open the Timeline or Storyboard 
workspace in CyberLink PowerDirector by default.

• Link objects across tracks when moving/deleting content in 
Video track: Links titles, video effects, music and PiP clips to clips 
in the Master Video track. Checking this option moves these clips 
when a video clip in the Master Video track is moved. Uncheck 
this option to allow for the movement of all Timeline clips 
separately.

• Add transition between photos when applying Magic Motion: 
Adds a transition effect between adjacent photos when you use 
the Magic Motion tool.
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• Durations: Set default durations (in seconds) for image files and 
the different effects in the timeline.

• Auto Save Project: Check this to have CyberLink PowerDirector 
auto save your project. You can enter a specific time in the field 
provided. This ensures you don’t lose your changes if there was a 
power outage or your computer crashed and you forgot to save 
your creation.

Confirmation Preferences
To set your confirmation preferences, click Edit > Preferences... The 
Preferences dialog box opens. Click the Confirmation tab. Available 
options are as follows:

• Always prompt me when TV format conflicts: Check this 
option to enable a warning message when you add a video clip 
59



CyberLink PowerDirector 6
to the workspace whose TV format (NTSC/PAL) conflicts with that 
of the video clips already located in the workspace.

• Enable file deletion from hard drive: Check this option if you 
would like to enable deletion of files from your hard drive from 
within the Media Library.

• Enable warning when chapters are removed during editing: 
Displays a warning message if chapter points have been deleted 
during video editing.

• Always prompt me when widescreen is not supported: Check 
this option if you would like CyberLink PowerDirector to prompt 
you when the widescreen format is not supported.
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Capture Preferences
To set your capture preferences, click Edit > Preferences. The 
Preferences dialog box opens. Click the Capture tab. Available options 
are as follows:

• Add captured files to Library: Check this option to import 
captured files into the Media Library directly after capture.

• Add captured files to workspace: Check this option to import 
captured files into the workspace directly after capture.

• Use video overlay for capture: Keep this option checked during 
capture unless you have an older VGA card that does not support 
video overlay. (Unselecting this option in this event avoids the 
unsupported overlay display error.)

• Enable automatic file replacement when recording voice-
over: Check this option to overwrite existing audio if the voice-
over overlaps during recording.
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• Enable CyberLink MPEG@Best: Check to balance capture speed 
and video quality when you capture MPEG video. 

• Do not detect scenes during capture: Check this option if you 
do not want to activate the auto scene detection function during 
capture.

• After capture, detect scenes by changing of video frames: 
Check this option to perform scene detection during video 
capture. In scene detection, CyberLink PowerDirector compares 
captured frames to decide when there is a scene change. Each 
scene is saved as a file as recording continues.

• During capture, detect scenes by timecode, and save each 
scene as a separate file (DV-VCR mode only): Check this option 
to detect scene-break signals and to save each scene as a 
separate file. (DV camcorder generate a scene-break signal on 
the tape whenever users release the REC button.) This feature is 
only available in DV camcorder capture.

• DV Parameters button: Click this button to set the buffer 
parameters for your DV camcorder. Setting a buffer time ensures 
that your DV camcorder and your batch capture or DV writing 
device begin at the same time. Without a buffer, batch capturing 
or writing to tape may begin before the camcorder is engaged.
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Produce Preferences
To set your production preferences, click Edit > Preferences. The 
Preferences dialog box opens. Click the Produce tab. The available 
option is as follows:

• Output only selected tracks: Check this option to output only 
the selected tracks. The tracks that are not selected will not be 
produced.
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Chapter 3:

Creating Your 
Story

Now that you have all of your video, photos and audio ready, this chapter will 
guide you through the process of turning your collection of media into 
professional-looking video movies and photo slideshows. It also describes how 
to view project information and to preview your movie during production.

This chapter contains the following sections:

• "Edit Window Overview" on page 66

• "Adding Media to Workspace" on page 79

• "Editing Your Media" on page 102

• "Using Magic Tools" on page 115

• "Modifying Effects" on page 129

• "Audio Mixing and Voice Overs" on page 158

• "Chapters" on page 163

• "Add Subtitles" on page 165
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Edit Window Overview
Before you get started with the editing process, it is important that you 
become familiar with the Edit window. The section provides you with 
an overview of some of its key features and functions.

Working with Project Files
Each time you start working on a new movie production or photo 
slideshow, you create a new project that is saved as a .pds file that is 
used exclusively by CyberLink PowerDirector. This section describes 
working with CyberLink PowerDirector project files. These are the basic 
commands for managing new and existing projects.

Create a New Project
To create a new project file, click File > New Project. If an unsaved 
project file is open in the workspace, you are prompted to save it.

Save a Project
To save the current project file, click File > Save Project. (To save the 
current project file under a different file name, click File > Save Project 
As....) In the dialog box that opens, enter a file name and location, then 
click Save.

Auto Save Project
You can configure CyberLink PowerDirector to automatically save your 
project every few minutes in Preferences. Auto save ensures that you 
don’t lose your changes if there was a power outage or your computer 
crashed and you forgot to save your creation. See "Editing Preferences" 
on page 58 to enable and configure this feature.
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Open an Existing Project
To open an existing project file, click File > Open Project.... If an 
unsaved project file is open in the workspace, you are prompted to save 
it. In the dialog box that opens, locate the project file you want to work 
with, then click Open.

New Workspace
To clear the workspace of all clips and effects, click File > New 
Workspace.

View Project Properties
You can view such project properties as the creation date, the author’s 
name, associated keywords, etc.

To view project properties, click File > Project Properties....

Set the Project’s Aspect Ratio
Before you start working on your project, you should set your movie’s 
aspect ratio. The default aspect ratio is 4:3, but if you want your 
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production to utilize a widescreen TV you may change the aspect ratio 
to 16:9, provided that the media clips you have are also in widescreen 
format. To modify the aspect ratio for your media, see "Adjust a Video 
Clip’s Aspect Ratio" on page 112.

To set the aspect ratio for your movie, click Edit > Aspect Ratio > 4:3 or 
16:9. The preview window will change according to the aspect ratio 
you have chosen.

Note: It is important that you set the aspect ratio of your movie before you 
start adding clips to the timeline/storyboard. You can not change the aspect 
ratio of your project once your started editing clips.
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The Library Window
The Library window contains all of the media in CyberLink 
PowerDirector, including your video, photos and music files and the 
effects and additions you apply to your media. The media content that 
is displayed in the Library window is dependent on the room you select. 

The Library window is displayed as follows:

Import media button

Library menu button

Detect scenes button

Filter drop-down list

LibraryRoom buttons
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To switch rooms and the content that is displayed in the Library, use the 
buttons on the left side of the window. These buttons are displayed 
below:

Each of these buttons opens a ‘room’ and displays a corresponding 
library of media, effects or access to controls for mixing your audio. By 
default, the Library opens to the Media Room. However, the Library 
retains the same buttons and functions in each of these views.

Media Room
The Media Room contains access to the storage area, or library, 
of the media that you can use in your project. The type of media 
clips that appear in the Media Room depend on the selection 
you make in the Filter drop-down list.

Effect Room
The Effect Room contains a library of special effects that can be 
applied to video or image clips in your project. For more 
information, see "Adding Video Effects" on page 88.

Media Room button

Effect Room button

Titles Room button

Transition Room button

Audio Mixing Room button

Voice-Over Recording Room button

Chapter Room button

PiP Objects Room button

Subtitle Room button
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PiP Objects Room
The PiP Objects Room contains a library of graphics that you 
can add on the video or photo clip in the PiP Track. There are 
three main types of objects:

• static graphics
• motion graphics that fly through the clip
• decorative borders that can be added to frame your clip

Inserted objects are displayed in the PiP Track and can be 
modified in the PiP Designer. For more information, see 
"Modifying Objects" on page 131.

Title Room
The Title Room contains the library of titles that can be applied 
to your project to add credits or comments to your production. 
For more information, see "Adding Title Effects" on page 90.

Transition Room
The Transition Room is a library of transitions that can be 
applied between video or image clips in your project, helping 
to make edits appear smoother and more professional. For 
more information, see "Adding Transitions" on page 90.

Audio Mixing Room
The Audio Mixing Room contains audio mixing controls for all 
of the audio tracks in your project. For more information, see 
"Mix Audio Levels in the Audio Mixing Room" on page 159.

Voice-Over Recording Room
The Voice-Over Recording Room contains controls for 
recording a narration from a microphone while watching the 
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video clip the voice-over is to accompany. For more information, see 
"Record a Voice-Over" on page 160.

Chapter Room
The Chapter Room contains options for automatically or 
manually setting chapter markers. Setting chapters on your 
final disc allows viewers to jump from the menu page to the 
chapter markers you have set in order to navigate around your 
disc. For more information, see "Chapters" on page 163.

Subtitle Room
The Subtitle Room lets you add subtitles to your production 
manually or by importing a text file directly into CyberLink 
PowerDirector. For more information, see "Chapter Room" on 
page 72.

Managing Media in the Library
Once your clips are loaded, you can change the display of your media 
clips within the Library and remove clips you don’t need.

Sort Clips in the Library
Once your media clips are loaded into the Media Library, you can filter 
the display for a certain type of media for a simpler view or sort media 
files using different criteria.

• Select the type of media you want to view (or All Media) from 
the Filter drop-down list. Only those clips that belong to the 
media type you have selected are displayed in the Media Room.

• To change the way files are sorted, click . Select Sort by, then 
choose a sorting option (Name, Duration, File Size, Date, Type).

Note: Color boards can be sorted by Name, R (Red), G (Green), and B (Blue), 
or Date.
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• To change the way files are displayed in the library, click . 
Select Display As, then choose a display option (Thumbnails or 
Details).

Remove a Clip from the Library
To remove a media clip from the Library, do this:

1. Click  to open the Media Room.

2. Select the clip(s) you want to remove, then do one of the 
following:

• Press the Delete key.

• Click  and select Delete Selected.

• Right-click on the clip(s), then select Remove from Library 
or Delete from disk.

Note: The Remove from Library option makes the clip unavailable in the 
Library but does not affect the original media file on your hard disk. The 
Delete from Disk option both removes the clip from the Library and 
deletes the original file on your hard disk.
73



CyberLink PowerDirector 6
Rename a Clip in the Library
Clips you import into the Library retain their original file names, which 
are often non descriptive and sometimes confusing to use in a video 
editing project. By using an alias, you can rename any clip in the Library 
to better suit your project. (For example, you may wish to use the alias 
“first video clip” instead of “video_005.mpg.)

To rename a clip using an alias, do this:

1. Right-click the clip you want to rename and select Use Alias.

2. Enter a name and press Enter on your keyboard or click outside the 
name box. The clip appears in the Library using the alias.

Restore a Clip’s Original File Name
Although using an alias is handy while working on your video project, 
you may find it necessary to view the original name of the clip (for 
example to verify which version of a clip you are using).

To restore a clip’s original name, right-click the clip you want to rename 
and select Restore to Original Clip Name. The clip will revert to the 
original clip name in the Library.
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View Clip Properties
If you want to view information about a media clip in the Library or the 
workspace (such as its format, file path, size, frame rate, etc.), you can 
view the clip’s properties.

To view clip properties, right-click the clip and select Properties. The 
Properties dialog box opens.
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The Workspace
The workspace is the section of the Edit window where your create your 
project by adding media clips, effects, transitions, etc. The workspace 
has two different views, the Timeline and Storyboard view, which can 
be accessed by clicking on the Timeline or Storyboard buttons.

Note: You can set which workspace view is displayed by default in "Editing 
Preferences" on page 58. 

You load media and effect clips into specific tracks in the workspace, 
move them to different locations in your story, or remove them from 
the workspace. This section describes how to add clips to the proper 
track and how to manage clips once they have been added.

Timeline View
The Timeline view lets you view your entire project based on running 
time. This view is useful when wanting to insert effects, subtitles, etc. at 
a specific moment or time. The Timeline view also provides a view of 
various tracks and where they appear in the timeline. To switch to 

Timeline view, click . 
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Media Tracks

The Timeline contains the following tracks:

Locking/Unlocking Tracks in the Timeline

To lock a track in the Timeline, click  at the left of the track. When a 
track is locked, you cannot add new clips to the track, nor move or edit 

the clips it contains. To unlock a track in the Timeline, click  at the 
extreme left of the track. When a track is unlocked, you can freely add, 
move and edit clips. For more information, see "Working with Clips in 
the Workspace" on page 91.

Showing/Hiding Tracks in the Timeline

To hide a track in the Timeline, first click  in the Preview window, 

then click  at the extreme left of the track. When a track is hidden, it 

Track Description

Master Video Track: contains your project’s main video 
and/or image clips.

Effect Track: contains special effects that apply to the 
video or image clip in the Master Video Track at the same 
location.

PiP Track: contains video/image clips and objects that 
are inserted over any clip in the Master Video Track that 
appear during the PiP effect’s duration.

Title Track: contains title effects that appear over any 
clips in the Master Video Track that occur during the title 
effect’s duration.

Voice Track: contains a narrative voice-over or second 
audio clip.

Music Track: contains your project’s main audio and 
music clips.
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will not be displayed in the Preview window. This way you can preview 
your project by tracks and concentrate on the track you are working on. 

To display a track that has been hidden in the Timeline, first click  

in the Preview window, then click  at the extreme left of the track. 
For more information, see "Preview Your Movie in the Preview Window" 
on page 99.

Resizing the Ruler

You can resize the ruler for a more expanded or more condensed view 
of your production. To resize the ruler, click inside the ruler and drag. 

Expand the ruler for more a precise view, which is especially handy 
when aligning clips and effects, or condense the ruler for a global 
overview of your entire production.

Storyboard View
The Storyboard view is essentially a large graphical display of your 
project. The Storyboard view is useful to assist you visualize the scenes 

and the overall production. To switch to storyboard view, click .

Note: A number of features are unavailable in the Storyboard view. If you try 
and perform a function that is not available in this view, CyberLink 
PowerDirector automatically switches to the Timeline view.
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Adding Media to 
Workspace

Now you can begin putting your final production together by adding 
media and effects to the workspace. You can also use the Magic Movie 
Wizard or the Slideshow Designer to quickly create a production if you 
are short on time or to use as a guideline to get to you started.

Certain media clips may only be added to specific tracks, for example 
titles to the Title Track, transitions to the Transition Track, or audio to 
the Voice or Music Track. When you select a media clip, the tracks that it 
can be added “light up”.

Magic Movie Wizard
If you are new to the editing process and not sure how or where to get 
started, then the Magic Movie Wizard can help. The Magic Movie Wizard 
can take all of your media and create a dazzling movie production in 
just a few steps. The created production can then be edited and refined 
in the workspace, outputted to a file or burned to disc.

To use the Magic Movie Wizard to create a movie production, do this:

Note: The Magic Movie Wizard provides the option of using all the media in 
the Media Library, all the media currently in the workspace or all currently 
selected media. If you only want to use a specific number of clips, select the 
clips you want to use before you begin.
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1. Click  to open the Magic Movie Wizard.

2. Select the location of your media that you want to include in the 
created production as follows:

• Library: selecting Library will cause the Magic Movie Wizard 
to use all of the media currently located in your Media 
Library.

• Workspace: select ing Workspace will cause the Magic 
Movie Wizard to use only the media that is currently located 
in the workspace timeline or storyboard.

• Selected Items: selecting Selected Items will cause the 
Magic Movie Wizard to only use the media that was 
selected when the Magic Movie Wizard was launched.

Note: You can add additional media to your production in the workspace 
after the production has been created.
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3. Click  to display the Add Music page.

4. User the  button to select specific music you want to include in 
your movie production.

Note: You can add as much music as you want to include. If you don’t select 
any music, the Magic Movie Wizard will use music from your Media Library if 
Library was selected on the previous page

5. Set the audio mixing levels for your music with the available slider. 
• Dragging the slider towards More music will cause the 

music’s audio to become louder, while reducing the video’s 
audio. Conversely, dragging the slider towards More video 
will cause the video’s audio to be louder, while reducing the 
music’s audio. 
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6. Click  to display the Select Style page.

7. Select a pre-defined style to assist the Magic Movie Wizard to add 
the right opening title, video effects and transitions that match the 
theme or purpose of your movie production. 
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8. Click  to display the Specify Duration and Split Ratio 
page.

9. Choose to do one of the follow:
• Enter a desired duration in the New duration field. 
• Click the Fit duration to background music button to have 

the video’s duration match the selected music.

• Leave the duration as is to let the Magic Movie Wizard 
decide the best duration to use.

10. Set the ratio between your photos and video with the available 
slider.Dragging the slider towards More photo will cause the 
Magic Movie Wizard to display more photos and less of the video 
files in the final movie production. Conversely, dragging the slider 
towards More video will cause the Magic Movie Wizard to display 
more of the videos and less of the photos in the final movie 
production.
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11. Click  to begin generating your movie production.

12. Once the Magic Movie Wizard is done, you can view a preview of 
the production using the playback controls.
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13. If you are not satisfied with the production, use the  
button to return to the previous windows and change the 
duration, style etc. to alter the production.

14. Once you are satisfied, click  to display the Finished 
window.

15. Click  to finalize your production. The Magic Movie 
Wizard will insert the created production into the Timeline.

Adding Video, Photos and Audio to 
the Workspace

The sections below describe the procedures for adding each kind of 
media clip into the workspace.

Note: You may prefer to add clips in Storyboard view, since this view is 
simpler than the Timeline view. However, clips can only be added to the 
Video track in this view. Therefore, this section uses the Timeline view in all of 
the procedures.
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Add Video Clips & Photos
You can add video clips and photos to either the Master Video Track or 
the PiP (picture-in-picture) Track. To create the basic framework of your 
movie, add video clips and photos to the Master Video Track. Add 
media to the PiP track only to create a picture-in-picture effect.

To add video clips or photos to the workspace, do this:

1. Click  to open the Media Room.

2. Select Video, Images or All Media from the Filter drop-down list 
to sort the clips in the Media Library.

3. Select a clip and then add it to the workspace in one of the 
following ways:

• Click  to add the clip to the Video Track or 

 to add the clip to the PiP Track.
• Drag clips to a desired position in the Video or PiP Track. 

When adding clips to the Master Video Track, you cannot 
leave an empty gap between the last clip and the new clips 
you are adding. Clips added to the end of the Master Video 
Track follow immediately after the final clip in that track.

Note: You may select several clips and drag them together into the same 
track, provided all of the clips are compatible with the destination track.

• Right-click on a clip and select Add to Video Track or Add 
to PiP Track as required.

Note: Use the PiP Designer to customize the PiP effects in your movie 
production. See"Modifying a PiP Effect or Object" on page 130 for more 
information.

Add Color Boards
The use of color boards allows you to insert solid frames of color into 
your movie. Color boards are really useful as quick transitions between 
video clips or as background for titles and ending credits.
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Color boards are not media files, but they can be applied to the 
workspace and managed in the Media Library just like any other media. 
You can add color boards to either the Master Video or PiP Track.

To add a color board to the workspace, do this:

1. Click  to open the Media Room.

2. Select Color Boards from the Filter drop-down list. The color 
boards appear in the Library.

3. Select a color board and then add it to the workspace in one of the 
following ways:

• Click  to add the color board to the Master Video 

Track or  to add the color board to the PiP Track.
• Drag one or more color boards to a desired position in the 

Master Video or PiP Track. When adding clips to the Master 
Video Track, you cannot leave an empty gap between the 
last clip and the new clips you are adding. Clips added to 
the end of the Master Video Track follow immediately after 
the final clip in that track.

• Right-click on a clip and select Add to Video Track or Add 
to PiP Track as required.

Add Audio Clips
Using audio clips allows you to add background music or a narrative 
voice-over to your movie. CyberLink PowerDirector provides two tracks 
for audio media (the Music and Voice Tracks), which you can use 
interchangeably.

Note: Audio files can only be added to the workspace in Timeline view. If you 
drag an audio file to the workspace in Storyboard view, the workspace 
automatically switches to Timeline view.

To add an audio clip to the workspace, do this:

1. Click  to open the Media Room.
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2. Select Audio or All Media from the Filter drop-down list.
3. Select an audio clip and then add it to the workspace in one of the 

following ways:

• Click  to add the audio clip to the Voice Track or 

 to add the audio clip to the Music Track.
• Drag one or more audio clips to a desired position in the 

Voice or Music Track. Audio clips can be added at any point 
in this track.

• Right-click on a clip and select Add to Voice Track or Add 
to Music Track as required.

Adding Video Effects, Objects, Titles 
and Transitions

The sections below describe the procedures for adding video effects, 
objects, titles and transitions into the workspace.

Note:  Video effects, objects, titles and transitions can only be added to the 
workspace in Timeline view. If you drag one of these to the workspace in 
Storyboard view, the workspace automatically switches to Timeline view.

Adding Video Effects
To add a video effect to a portion of a clip in the Timeline, do this:

1. Click the  button to open the Effect Room.

2. Select an effect and then add it to the workspace in one of the 
following ways:

• Click  to add the effect to the Effect track at the 
current position of the Timeline slider.

• Drag an effect from the Effects Room into the Effect Track 
directly beneath the clip(s) in the Master Video Track that 
you want to apply it to.
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• Right-click on an effect and select Add/Replace in Timeline 
to add or replace the Effect track at the current position of 
the Timeline slider as required.

• You can add a random video effect at the current position of 

the Timeline slider by clicking  and then selecting Add 
Random Video Effect.

3. Click the Modify button to edit the effect’s options. See 
"Modifying a Video Effect" on page 129.

To add a video effect to an entire clip in the Timeline, do this:

1. Click the  button to open the Effect Room.

2. Select an effect, drag it to the Master Video Track and then drop it 
on top of the clip you want to apply it to. The video effect will be 
applied to the entire duration of the clip.

3. Click the Effect button to edit the effect’s options. See "Modifying 
a Video Effect" on page 129.

Adding PiP Objects
To add a PiP object to the Timeline, do this:

1. Click  to open the PiP Objects Room.

2. Select an object and then add it to the PiP Track in the workspace 
in one of the following ways:

• Drag an object from the Objects Room into the desired 
position in the PiP track.

• Right-click on an object and select Add/Replace in 
Timeline to add or replace the object at the current 
position of the Timeline slider as required.

3. Click the Modify button to edit the objects placement, motion and 
more in the PiP Designer. See "Modifying a PiP Effect or Object" on 
page 130 for more information.
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Adding Title Effects
To add a title effect to the Timeline, do this:

1. Click  to open the Title Room.

2. Select a title effect and then add it to the workspace in one of the 
following ways:

• Click the  button located below the Library to 
add the effect to the Title Track at the current position of the 
Timeline slider.

• Drag an effect from the Title Room into the desired position 
in the Title Track.

• You can add a random title effect at the current position of 

the Timeline slider by clicking  and then selecting Add 
Random Title Effect.

3. Edit the title effect in the Title Designer that opens. See "Modify a 
Title Effect" on page 144.

Adding Transitions
To add a transition to the Timeline, do this:

1. Click  to open the Transition Room.

2. Select a transition effect and then drag it from the Transition Room 
to between the clips in the Master Video track where you want it to 
be applied.

3. Set the transition’s duration. See "Set a Clip’s Duration" on page 
107 for more information.

To add random transitions to all clips in the Timeline, do this:

• Click on a transition and then on the  button located 
below the Library to add a random transition to all clips in the 
timeline.
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• Click on a transition and then on the  button located 
below the Library to add a random fading transition to all clips in 
the timeline.

• Click on  in the library window and selecting Apply Random 
Transition Effect to All or Apply Fading Transition to All.

Working with Clips in the Workspace
Once your clips have been added to the workspace, you can move them 
to different locations on the same track as required. Only audio clips 
can be moved between tracks.

You may find moving media clips easier in Storyboard view, especially if 
the clips have extremely short durations, or if you need to move them a 
relatively long distance over the workspace.

Note: Moving a clip in the Video track automatically adjusts the duration of 
the effects applied to it to synchronize with the remaining clips in the Master 
Video Track. Some effects may therefore disappear or change length when 
you move a clip.

Select Clips in the Workspace
To select clips in the workspace, do one of the following:

• To select clips in a series, click on the first clip, press the Shift key 
and then select the last clip.

• To select multiple that are not beside each other, press the Ctrl 
key, then select the required clips one by one.

• To select all of the clips in a track, right-click inside the track and 
then select Select All.

Cut/Copy/Paste a Clip in the Workspace
You can cut, copy and paste media clips in CyberLink PowerDirector’s 
workspace.
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When you paste, clips appear at the current position of the Timeline 
slider. If that position occurs within the duration of a media clip, the 
new clip is pasted immediately after that clip. If the Timeline slider is 
positioned in a gap between clips, the new clip is pasted and truncated 
(if necessary) to fit in the gap (PiP/Music/Voice tracks only). If the 
Timeline slider is positioned after the last clip, the new clip is pasted 
immediately after the last clip.

Align Clips in the Timeline
You can align PiP, effect and title clips to the edge of the clip above 
them in the Master Video Track to ensure their starting and ending 
times coincide.

To align a clip, right-click it in the timeline, then select Align to Edge. 
The Align to Edge dialog box opens.

The Align Left tab displays options for stretching the clip’s left edge. The 
following options are available:

• Extend to the left edge: Extends the clip to the next available 
border to the left in the Master Video Track.

• Shrink to the right edge: Shrinks the clip to the next available 
border to the right in the Master Video Track.

The Align Right tab displays options for stretching the clip’s right edge. 
The following options are available:
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• Extend to the right edge: Extends the clip to the next available 
border to the right in the Master Video Track.

• Shrink to the left edge: Shrinks the clip to the next available 
border to the left in the Master Video Track.

Remove a Clip from the Workspace
To remove a clip from the workspace, select the clip(s) you want to 
remove, then do one of the following:

• Press the Delete key.

• Click the Remove  button.
• Right-click the clip, then select Remove. 
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Slideshow Designer
The Slideshow Designer in the easiest way to take your photos and turn 
them into dynamic slideshows.

Auto Create Slideshow
To auto create a slideshow in the Slideshow Designer, do this:

1. Drag all the photso that you want in the slideshow into the 
timeline and then click on the Slideshow button to launch the 
Slideshow Designer.

2. Select a slideshow style from the available list.

3. Click  to close the Slideshow Designer and place the 
slideshow in the workspace.
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Preview your Production
While you are creating your video production, you will be constantly 
viewing your production to ensure it is what you want. CyberLink 
PowerDirector offers two preview methods for viewing your 
production. You can choose to view a particular clip or view the entire 
movie production.

Preview Window
The easiest way to preview a media is by playing it in the preview 
window to the right of the Library. Any media clip that appears in the 
Library or the workspace can be previewed in this window. However, 
playback controls are only available for video and audio media.

Time display

Seek by

Slider

Movie
mode

Open Media Viewer/Media Editor

Clip
mode
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Media Viewer
The Media Viewer is similar to the preview window but offers additional 
functions for trimming video clips. Previewing media in the Media 
Viewer gives you a larger preview picture than the preview window.

To launch the Media Viewer, click  in the preview window.

The Media Viewer allows you to preview media clips as well as your 
entire movie production in a large, resizable window. 

You can configure the preview resolutions and select between instant 
preview or rendering preview.

Preview window
Provides playback controls to preview your 
movie

Playback controls
Allow you to control playback of clips
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Preview Clips
As you add media to your production, it is important to preview the 
effect your media clips have on the story you are telling. You may want 
to preview imported clips, for example, to verify their content, or to 
preview clips you have captured to see if they contain sections you 
need to trim.

Preview a Clip in the Preview Window
To preview a media clip in the preview window, do this:

1. Click the clip you want to preview. The clip appears in the preview 
window.

Note: When previewing clips in the workspace, ensure that the preview 
window is in Clip mode. If the preview is in Movie mode, click the Clip 
button before previewing a clip.

2. Locate the point at which you want to begin your preview. You 
may do this in one of the following ways:

• Drag the Timeline slider. 
• Drag the preview window slider. 
• Enter a timecode in the timecode box. 

3. Press . The preview starts from the point you have specified. 
4. Use the playback buttons to control the preview.

Preview an Effect in the Preview Window
Previewing effects is an important step in ensuring not only that the 
effect is applied to the proper clip in the proper location, but that the 
intensity of the effect is suitable for that location in the movie. You will 
likely preview effects constantly as you apply them to the workspace, 
and it is a good idea to preview your movie at regular intervals to 
ensure that your editing is proceeding as you planned.

To preview an effect in the preview window, do this:
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1. Click the effect in the Timeline. The media clip the effect is applied 
to appears in the preview window.

2. Locate the point at which you want to begin your preview. You 
may do this in one of the following ways:

• Drag the Timeline slider. 

• Drag the preview window slider. 
• Enter a timecode in the timecode box. 

3. Press . The preview starts from the point you have specified. 

4. Use the playback buttons to control the preview.

Preview a Clip in the Media Viewer
To preview a clip in the Media Viewer, do this:

1. Select the clip in the Timeline. The clip appears in the Preview 
window.

2. Locate the point where you want to begin your preview. You may 
do this in one of the following ways:

• Drag the Timeline slider. 

• Drag the preview window slider. 
• Enter a timecode in the timecode box. 

3. Click  in the preview window.

4. Select Instant Preview with Media Viewer. The clip appears in the 
Media Viewer.

Note: You may also use Rendering Preview with Media Viewer, 
however the rendering process takes longer to complete

5. Press . The preview starts from the point you have specified. 

6. Use the playback buttons to control the preview.

Preview an Effect in the Media Viewer
To preview an effect in the Media Viewer, do this:
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1. Click the effect in the Timeline.

2. Locate the point where you want to begin your preview. You may 
do this in one of the following ways:

• Drag the Timeline slider. 

• Drag the preview window slider. 
• Enter a timecode in the timecode box. 

3. Click  in the preview window.

4. Select Instant Preview with Media Viewer. The clip appears in the 
Media Viewer.

Note: You may also use Rendering Preview with Media Viewer to 
preview a rendered movie, however the rendering process takes a long to 
complete.

• You may drag an edge or a corner to resize the Media Viewer 
window.

• You may preview the clip in different resolutions: High (640x480), 

Normal (320x240), or Low (160x120). Click  and select the 
resolution you want.

5. Press . The preview starts from the point you have specified. 

6. Use the playback buttons to control the preview.

Preview Your Movie
Before you commit your movie to disc, it’s a good idea to preview it to 
make sure all of your clips and effects are working to create the movie 
you want. It is highly recommended that you preview your entire movie 
at least once before production.

Preview Your Movie in the Preview Window
You can preview your movie at any point during the editing process in 
order to ensure that your editing is going smoothly. Using the Timeline 
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slider, you can preview your movie production from any point within 
the Timeline.

Note: When previewing clips in the workspace, ensure that the preview 
window is in Movie mode. If the preview is in Clip mode, click the Movie 
button before previewing your movie production.

1. Click the Movie button in the preview window.

2. Locate the point where you want to begin your preview. You may 
do this in one of the following ways:

• Drag the Timeline slider. 
• Drag the preview window slider. 

• Enter a timecode in the timecode box. 
3. Press Play. The preview starts from the point you have specified. 
4. Use the playback buttons to control the preview.

Preview Your Movie in the Media Viewer
To preview your movie in the Media Viewer, do this:

1. Click the Movie button in the preview window.

2. Locate the point where you want to begin your preview. You may 
do this in one of the following ways:

• Drag the Timeline slider. 
• Drag the preview window slider. 

• Enter a timecode in the timecode box. 

3. Click  and select Instant Preview with Media Viewer. The 
Media Viewer opens

Note: You may also use Rendering Preview with Media Viewer to 
preview a rendered movie, however the rendering process takes a long to 
complete

• You may drag an edge or a corner to resize the Media 
Viewer window.
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• You may preview your movie in different resolutions: High, 

Normal or Low. Click  and select the resolution you want.

4. Press . The preview starts. Use the playback buttons to control 
the preview.
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Editing Your Media
Once you have your media in the workspace you can perform edits and 
refinements to it. ‘Editing’ is a broad term that encompasses a number 
of different functions: you can, for example, trim unwanted sections 
from video or audio clips, increase or decrease the speed of a video clip, 
or touch up your photos. This section describes all of the editing 
processes that you can perform on the different types of media clips.

Note: The functions in this section can only be performed in Timeline view.

Split a Clip
You can split a media clip into two clips at the current position of the 
Timeline slider. The procedure is the same for any type of clip (video, 
photo, audio or effect) except for transitions.

To split a media clip, do this:

1. Select the clip you want to modify.

2. Move the Timeline slider to the position where you want to split 
the clip.

3. Click Split. The clip is split into two independent clips that can be 
moved or modified separately in the workspace.

Note: Splitting a video or audio clip does not delete any portion of the 
content. Both halves of a split video or audio clip can be stretched back to 
any length up to the original duration.
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Trim a Video or Audio Clip
Video clips captured from external capture devices often contain 
unwanted portions at the beginning, between the scenes you want or 
at the end. These unwanted portions can easily be removed in 
CyberLink PowerDirector using the Trim function.

Likewise, if you want to tailor your audio clip to fit the duration of a 
video clip, you can easily trim your audio clip to a desired length.

Note: Trimming a video or audio clip does not delete any portion of the 
content.

Perform a Simple Trim
To trim a video or audio clip, do this:

1. Select the clip you want to modify.

2. Click Trim. The Trim window will be displayed.

3. Enter a mark in and mark out time. You may do this in one of the 
following ways:

• Enter in the timecodes in the corresponding timecode 
boxes.
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• Drag the mark in/mark out sliders to the correct time 
positions.

• Navigate to the desired time in position using the playback 

controls and click the Mark in button . Navigate to the 

desired time out position using the playback controls and 

click the Mark out button .

Note: To make a more precise cut, click  to open the timeline magnifier 

and use the zoom in  button or zoom out . This feature is optional and 
not provided in all versions.

4. Click  to close the Trim window and complete the 
specified trim.

Perform a Multiple Trim
You can trim multiple portions from a video clip, resulting in individual 
clips, which are independent of the original clip. You can also detect 
scenes using the Multi Trim tool. Detected scenes, by contrast, are not 
split from the original clip, but are simply divisions contained within it.

To perform a multiple trim on a video clip, do this:

1. Select the clip you want to modify.
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2. Click Multi Trim. The Multi Trim window will be displayed.

3. Navigate to the mark in time by doing one of the following:
• Enter in the timecode in the timecode box above the 

control panel.

• Drag the mark in to the correct time positions.
• Navigate to the desired time in position using the playback 

controls.

4. Click  to set the mark in point.

Note: To make a more precise cut, click  to open the timeline magnifier 

and use the zoom in  button or zoom out . This feature is optional and 
not provided in all versions.

5. Navigate to the mark out time, then click  to set the mark out 
point. The scene you set appears in the pane to the right of the 
preview window.

• To detect scenes automatically, click . For more 
information, see "Detect Scenes in a Video Clip" on page 50.

• To remove a scene, select it and then click Remove.
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• To split a long scene into two shorter scenes, navigate to a 
position inside a chapter you have already set, then click 

 to split the scene.

Note: You can continue to cut multiple scenes from the video clip. Each 
scene, however, must have a duration of at least two frames.

6. Click OK.

Trim by Dragging an Edge
You can trim any kind of media clip in the Timeline (including audio, 
video, image clips and color boards) by dragging either edge of the clip. 
You may find trimming a clip easier this way if you first expand the ruler.

Note: Video and audio clips cannot be lengthened beyond their original 
duration.

To trim a media clip by dragging an edge, do this:

1. Select the clip you want to modify.

2. Position your cursor at one end of the clip and drag the end of the 
clip to the new position.

Note: You can drag the edge of a clip to lengthen it or to shorten it. If you 
compress the start of a video or audio clip, playback begins at a later frame 
within the clip. If you compress the ending, playback ends at an earlier frame 
within the clip.
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Set a Clip’s Duration
Within the timeline you can set the amount of time:

• a single photo clip is displayed
• a title effect is displayed
• a video effect is applied to the Master Video track
• a PiP effect or object is displayed
• a transition takes to complete

To set a clips duration, do one of the following:

• select the clip, click the Duration button, enter the new duration 
in the Duration Settings window and then click ok. 

• right click on the clip, select Set Duration, enter the new 
duration in the Duration Settings window and then click ok.

• select the clip, position your cursor at one end of the it and then 
drag the end of the clip to the new position.

Note: Transitions can only be lengthened to half of the duration of the 
shortest clip they affect.
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Mute an Entire Media Clip
You may wish to mute the audio output of an entire media clip. To do 
this, right-click the clip and select Mute Clip. Any audio volume keys 
you have added are hidden.

To restore sound to the track, right-click the track and uncheck Mute 
Clip. The audio volume keys you have added are restored.

Mute an Entire Track
You may wish to mute the audio output of an entire track. To do this, 
right-click the track and select Mute Track. Any audio volume keys you 
have added are hidden.

To restore sound to the track, right-click the track and deselect Mute 
Track. The audio volume keys you have added are restored.

Change the Speed of a Video Clip
Slow-motion or fast-motion effects can grab your audience’s attention 
as well as break up the rhythm of a movie.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
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2. Click Speed. The Video Speed Options panel is displayed.

3. Select the desired Audio setting, as follows:

• Select Stretch to stretch the audio portion to the same 
proportion as the video portion.

• Select Mute button to mute the audio all together.
4. Set the new speed. You may do this in one of two ways:

• Drag the slider to increase or decrease the speed.
• Enter a duration in the New video length box. (This method 

allows more accurate control, as you can specify a length 
down to the frame level.)

Note: Clips with stretched audio can be slowed down to 0.50 X the original 
speed or sped up to 2.0 X the original speed. Clips with muted audio can be 
slowed down to 0.10 X the original speed or sped up to 10 X the original 
speed.

5. Click  to close the Video Speed Options panel. 
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Change the Color of a Visual Media 
Clip

You may wish to change the color attributes of a video clip, image or a 
color board in order to produce a surprising effect, or simply to emulate 
reality more closely. Either result is easy to achieve in CyberLink 
PowerDirector using the Magic Clean feature.

1. Select the image or video clips that you want to modify.
2. Click Color. The Clean Photo or Clean Video panel is displayed.

3. Set the color options that you want to apply:
• Brightness: the brightness/darkness of the image

• Contrast: the difference in proportion between lights and 
darks in the image

• Hue: the individual colors in the image
• Saturation: the depth of the colors in the image

• Sharpness: the clarity of details in the image
 110



Chapter 3: Creating Your Story
Note: Use the Original and Output buttons that become available on the 
control panel to compare the clips before and after the modification. You can 
also select Compare video qualities in split preview to see both 
views at the same time. 

4. Select Apply to all clips to apply your changes to all the clips in 
the workspace.

5. Click  to close the option panel.

Edit an Image Clip in PhotoNow!
To edit an image in the CyberLink PhotoNow! program, select an image 
clip, then click the Edit Image button.

 CyberLink PhotoNow! is the quickest way to touch-up your photos. You 
can resize, crop, rotate, remove red-eye, adjust the color and brightness 
and more. For more information on using the CyberLink PhotoNow! 
program, see that program’s online help.

Set a Video Clip’s Interlacing Format
All video clips have an interlacing (TV) format, which specifies how 
frames are displayed. Using video clips with conflicting (or incorrect) TV 
formats can result in degraded video quality in your final production.

Before you produce your movie, set all of the video clips to the same 
format. While CyberLink PowerDirector can normally detect and 
suggest the correct format, some interlaced video (such as a video with 
very little motion) may be misjudged as a progressive video.

CyberLink PowerDirector automatically produces interlaced video for 
DVD, SVCD and DV-AVI. Only change this setting if you are sure that 
CyberLink PowerDirector has wrongly set the format.

Note: This is an extremely important step to take before production, as it can 
drastically affect final video quality!

To set a video clip’s TV format, do this:
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1. Right-click the video clip whose interlacing format you want to set 
and select Set TV format. The Interlace and Progressive Settings 
dialog box opens.

2. Select an interlacing option:
• If you know the interlacing format you want to use, select 

the corresponding option
• If you do not know the interlacing formation you want to 

use, select Scan and Suggest Format. CyberLink 
PowerDirector scans the clip and automatically selects the 
best format.

3. Click OK.

Adjust a Video Clip’s Aspect Ratio
Video clips usually come in one of two aspect ratios, 4:3 or 16:9. 
Depending on your media clips and the medium you will be using to 
view your movie, you can adjust your movie’s aspect ratio accordingly. 
Before you produce your movie, set the aspect ratio for all of the video 
clips so that it matches the aspect ratio of your project.

Depending on the aspect ratio of your project and the aspect ratio of 
your clips, you have two options to choose from.

If your project aspect ratio is 4:3 and you wish to produce movies with 
clips of 16:9 aspect ratio, do this:
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1. Right-click on the video clip you want to adjust and select Set 
Aspect Ratio. The Clip Aspect Ratio Settings dialog box opens.

2. Select an aspect ratio option:
• If you know that the aspect ratio of your clip is 16:9, select 

the option The aspect ratio of the video is 16:9 and 
choose an option from the drop down list.

• If you know that the aspect ratio of your clip is neither 4:3 or 
16:9, select the option Neither 4:3 nor 16:9 and choose an 
option from the drop down list.

• If you do not know the aspect ratio of your clip, select 
Detect and Suggest. CyberLink PowerDirector scans the 
clip and automatically selects the best option.

3. Click OK.

If your project aspect ratio is 16:9 and you wish to produce movies with 
clips of 4:3 aspect ratio, do this:
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1. Right-click on the video clip and select Set Aspect Ratio. The Clip 
Aspect Ratio Settings dialog box opens.

2. Select an aspect ratio option:

• If you know that the aspect ratio of your clip is 4:3, select the 
option The aspect ratio of the video is 4:3 and choose an 
option from the drop down list.

• If you know that the aspect ratio of your clip is neither 4:3 or 
16:9, select the option Neither 4:3 nor 16:9 and choose an 
option from the drop down list.

• If you do not know the aspect ratio of your clip, select 
Detect and Suggest. CyberLink PowerDirector scans the 
clip and automatically selects the best option.

3. Click OK.
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Using Magic Tools
CyberLink PowerDirector offers a number of “magic tools” that can 
assist you to edit and touch up your audio, video and image clips. The 
magic tools can also help you add a creative style to your movie 
production or add the right background music. CyberLink 
PowerDirector offers the following Magic Tools:

• Magic Movie Wizard : Magically creates an edited movie 
blended with stylish effects and transitions. 

• Magic Clean : Cleans audio, video and image clips.
• Magic Motion : Adds zooms and pans to image clips.
• Magic Cut : Automatically condenses long video segments into 

shorter clips that contain only the best moments.
• Magic Fix : Fixes shaking videos, removes red-eyes and enhances 

the focus on photos.
• Magic Style : Creates professional movies with pre-designed 

style templates automatically.
• Magic Music : Adds background music that automatically 

adjusts to suit different durations.

When you open a magic tool, two buttons become available on the 
control panel for viewing the clip. These buttons switch the view in the 
Preview window to allow you to compare the clip before and after 
modification. Descriptions of the buttons are below:

• Original: Displays the clip as it appears before the current effect 
is applied.

• Output: Displays the clip with the current modification applied.

Magic Movie Wizard
If you are new to the editing process and not sure how or where 
to get started, then the Magic Movie Wizard can help. The 
Magic Movie Wizard can take all of your media and create a 
dazzling movie production in just a few steps. The created 
production can then be edited and refined in the workspace, 
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outputted to a file or burned to disc. See "Magic Movie Wizard" on page 
79 for detailed information on using this feature.

Magic Clean
CyberLink PowerDirector’s Magic Clean tool can be used to 
clean up image files, video files, as well as audio files. The Magic 
Clean tool can help revitalize your project by making your 
media clips cleaner, sharper, and brighter and your audio files 
crisper and clearer.

Perform Magic Clean on an Image Clip
When applied to image clips, CyberLink PowerDirector’s Magic Clean 
tool enhances the image for a sharper, brighter picture. This tool is ideal 
for use with photos taken when lighting is either insufficient or too 
intense.

To perform Magic Clean on an image, select the image clip in the 

timeline, then click . The Magic Clean panel is displayed.
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The following options are available:

• Apply Magic Clean: Check this option to enable Magic Clean for 
photos.

• Correct Lighting: Adjusts the brightness/contrast/saturation 
ratios. Best used to change the color settings if the clip contains 
portions that are overly dark or bright.

• Correct Backlight: Adjusts the backlighting in a clip. Best used to 
provide separation between a subject and the background or 
reduce the silhouette effect caused by too much backlight, for 
example from the sun.

• White Balance: Adjust the color temperature to correct the 
white balance or to create a specific atmosphere such as winter 
or summer. A warmer color shifts light toward the red; a colder 
color shifts light toward the blue.

• Color Adjustment: Adjusts the color attributes of an image in 
order to produce a surprising effect, or simply to emulate reality 
more closely. See "Change the Color of a Visual Media Clip" on 
page 110 for more detailed information.

• White Calibration: By indicating which portion of a picture 
should be white, Magic Clean automatically adjusts the colors 
accordingly to be more vivid and true.

• Compare qualities in split preview: Check this option to 
compare your changes in a split preview.

• Apply to all photo clips: Check this option to apply your 
changes to all the photo clips in the project.

• Click  to save your changes.

Perform Magic Clean on a Video Clip
When applied to video clips, CyberLink PowerDirector’s Magic Clean 
tool automatically adjusts the video output for a sharper, brighter 
picture. This tool is ideal for use with video recorded when lighting is 
either insufficient or too intense. There are also noise reduction options 
that can be applied to the audio portion of a video clip. See "Perform 
Magic Clean on Audio" on page 119 for more information.
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To perform Magic Clean on a video clip, select the clip in the timeline, 

then click . The Magic Clean panel is displayed.

The following options are available under the Clean Video Tab:

• Apply Magic Clean: Check this option to enable Magic Clean for 
video.

• Correct Lighting: Adjusts the brightness/contrast/saturation 
ratios. Best used to change the color settings if the clip contains 
portions that are overly dark or bright.

• Correct Backlight: Adjusts the backlighting in a clip. Best used to 
provide separation between a subject and the background or 
reduce the silhouette effect caused by too much backlight, for 
example from the sun.

• White Balance: Adjust the color temperature to correct the 
white balance or to create a specific atmosphere such as winter 
or summer. A warmer color shifts light toward the red; a colder 
color shifts light toward the blue.

• Color Adjustment: Adjusts the color attributes of an image in 
order to produce a surprising effect, or simply to emulate reality 
more closely. See "Change the Color of a Visual Media Clip" on 
page 110 for more detailed information.
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• White Calibration: By indicating which portion of a video should 
be white, Magic Clean automatically adjusts the colors 
accordingly to be more vivid and true.

• Compare qualities in split preview: Check this option to 
compare your changes in a split preview.

• Apply to all clips: Check this option to apply your changes to all 
the video clips in the project.

• Click  to save your changes.

Perform Magic Clean on Audio
The Magic Clean tool is ideal for use with audio that was recorded 
outdoor, in a room with poor acoustics and even in a car or other noisy 
location. The Magic Clean tool uses CLNR (CyberLink Noise Reduction) 
technology to improve output audio.

Note: Magic Clean can be applied to a video clip’s audio track or to a 
separate audio clip. The procedure for both is the same.

To perform Magic Clean on audio, select the clip in the timeline, then 

click .
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The Magic Clean panel is displayed. (Click on the Clean Audio tab if 
necessary).

The following options are available:

• Apply CyberLink Noise Reduction to remove audio noise: 
Check this option to enable Magic Clean for audio.

• Noise Type: Filters out background noise from the audio track. 
Drag the slider to remove more or less noise.

• Stationary noise: Applies a specific noise reduction 
technology to reduce background noise created by an 
object that stays in one position in a clip.

• Wind noise: Applies a specific noise reduction technology 
to filter out wind noise.

• Clicking noise: Applies a specific noise reduction 
technology to filter out clicking noise.

• Apply to all audio clips: Check this option to apply your 
changes to all the video clips in the project.

• Click  to save your changes.
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Magic Motion
CyberLink PowerDirector’s Magic Motion tool adds zooms or 
pans to an image clip, creating a motion effect in your final 
movie. The Magic Motion tool is ideal for turning slideshows 
into engaging presentations, especially when combined with 
Magic Music.

To perform Magic Motion on an image clip, select the clip in the 

timeline’s Video track, then click .

The Magic Motion panel is displayed.

The following options are available:

• Apply Magic Motion to the selected photo: Check this option 
to enable Magic Motion for the selected photo.

• Motion Effect: Select the motion effect you wish to use. Choose 
between Random, Zoom, Pan and Zoom, and Pan.

• Automatically set focus: Check this option to set the focus on 
the image automatically. Setting a focus in portrait layout pans 
across the image. Setting a focus in landscape layout zooms in 
on the image.
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• Apply to all photo clips: Check this option to apply the Magic 
Motion effect to all photos in the Master Video Track. (You can 
set the transition option in Editing Preferences. See "Editing 
Preferences" on page 58.)

• Click  to save your changes.

Once you apply the Magic Motion effect, an icon appears on the clip in 
the timeline, indicating that Magic Motion has been applied. If you later 
decide to remove the Magic Motion effect, open the Magic Motion 
dialog box and uncheck Apply Magic Motion to the selected photo.

Magic Cut
You can fit a video clip to a specific time by automatically 
cutting out unnecessary portions and keeping only the best 
moments. The Magic Cut feature uses “magic” video 
technology to locate and keep the most interesting moments, 
while discarding sections of lesser importance. The Magic Cut 
tool is ideal for condensing long video segments into shorter 
clips - for example, cutting one hour of video down to ten 
minutes.

Note: If the video segment you are using is shorter than 15 minutes in 
length, has been previously edited, or contains extremely important 
moments, you may prefer to edit it manually - for example, by using the 
Multi Trim function. See "Perform a Multiple Trim" on page 104.

To perform Magic Cut on a video clip, select the clip in the timeline’s 

Video track, then click .
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The Magic Cut panel is displayed.

The following options are available on the Duration tab:

• Auto apply transitions when possible: Check this option to 
automatically apply transitions between edited clips.

• Fit duration to background music: Use the total duration of the 
selected background music files as the new duration for Magic 
Cut. The new video duration will be exactly as long as the 
background music.

• : Add audio file to the background music list.

• : Delete the selected audio file from the background music 
list.

• : Move the selected audio file up the background music list.

• : Move the selected audio file down the background music 
list.

• New Duration: Enter the duration you would like to give to the 
clip (in hours:minutes:seconds:frames).

• Original Duration: Indicates the original duration of the video 
file.

The Criteria tab defines the rules used by Magic Cut to determine how 
to cut a video. The following options are available:
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• Scenes with zoom/pan: Adds a cross-fade effect between the 
clips created when you apply the Magic Cut effect.

• Scenes with people speaking: Selects clips with more or less 
dialog.

• Scenes with moving objects: Selects clips with more or less 
moving objects.

• Duration of scenes: Select whether to have longer or shorter 
scenes in your video by dragging the slider to set the desired 
duration of the scenes.

• Click  to save your changes.

Magic Fix
Magic Fix can stabilize videos taken with shaky hands. You can 
increase or decrease the level of correction, depending on the 
severity of the shaking. Magic Fix also can automatically 
remove red-eye and enhance the focus on photos that are out 
of focus.

Perform Magic Fix on a Video Clip
When applied to video clips, CyberLink PowerDirector’s Magic Fix tool 
stabilizes shaky videos. Magic Fix employs motion compensation 
technology to correct shaking in the videos. This tool is ideal for use 
with videos taken without a tripod or videos recorded on the move.

To perform Magic Fix on a video clip, select the clip in the timeline, then 

click .
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The Magic Fix panel is displayed.

The following options are available:

• Apply Video Stabilizer: Check this option to correct shaky 
video. Drag the slider to increase or decrease the level of 
correction.

• Compare video qualities in split preview: Check this option to 
compare your changes in a split preview.

• Apply to all video clips: Check this option to apply your changes 
to all the video clips in the project.

• Click  to save your changes.

Perform Magic Fix on a Photo Clip
When applied to photo clips, CyberLink’s PowerDirector’s Magic Fix tool 
removes red-eye and enhances photos. Magic Fix employs detection 
technology to automatically detect faces and correct red-eye. It also 
can enhance the focus on photos that are out of focus. This tool is ideal 
for use with photos taken during the night or without a tripod.
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To perform Magic Fix on a photo, select the clip in the timeline, then 

click .

The Magic Fix panel is displayed.

The following options are available:

• Remove Red-eye: Check this option to automatically detect 
faces and remove red-eye.

• Apply Re-focus: Check this option to enhance the focus on a 
photo. Drag the slider to increase or decrease the level of 
enhancement.

• Apply to all photo clips: Check this option to apply your 
changes to all the photo clips in the project.

• Click  to save your changes.
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Magic Style
Magic Style creates professional movies with pre-designed 
style templates automatically. Magic Style includes pre-
designed opening sequences, transitions and effects to 
automatically generate professional-looking movies on your 
timeline. It is perfect for use when you want to create great 
looking movies without the hassle of setting up the opening 
title, video effects and transitions yourself.

To add a Magic Style to the timeline, do this:

1. Select one or more video clips in the timeline, then click . The 
Magic Style panel is displayed.

2. Select a Magic Style Template from the library.
3. Click the Preview button to preview the result in the Preview 

window.

4. Click Apply to apply the template to the clip and update the 
timeline. You can modify the elements created by Magic Style in 
the timeline later.
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Note: Magic Style Templates can be expanded through Online purchases. 
Please see "Upgrade Your Software" on page 4 for more details.

Magic Music
Magic Music automatically adjusts the playback of the music 
clips it contains to fit any length from 5 seconds to 2 hours, and 
fine-tunes the audio for a smooth cut-off. The Magic Music tool 
is ideal for use with photo slide shows.

Note: Click the SmartSound button to view SmartSound-related 
copyright and purchasing information.

To add a Magic Music audio clip to the timeline, do this:

1. Click . The Magic Music panel is displayed.

2. Select a style from the drop-down menu.
3. Choose a song.

4. Set the desired duration in the duration box.
5. Select a variation, then drag it into the Music Track.
6. Drag the clip’s border to a suitable duration
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Modifying Effects
Most effects have a number of options that you can set individually to 
increase or decrease the intensity of the effect, or to achieve more 
creative results. In fact, this section describes some of the most creative 
functions found within the CyberLink PowerDirector program. 
Mastering the procedures found in this section will go a long way 
towards making you a digital video editing expert!

Modifying a Video Effect
Video effects are applied to the Effect Track at the time position of the 
video or image clip(s) that you want to affect. Video effects only affect 
the clips in the Master Video Track that appear within the effect’s 
duration.

To modify a video effect, do this:

1. Select the video effect in the Effect Track and click Modify (To 
modify a video effect that has been applied to the entire click, 
select the clip and click Effect).
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2.  The Effect Modifications Options panel is displayed.

3. Set the intensity level of the video effect. A preview of the effect 
appears in the preview window. (Options vary according to the 
video effect you select.)

• Many options provide a slider to increase or decrease the 
intensity of the effect.

• Some effects provide a drop-down list where you can 
choose effect options.

• Click  to link the changed settings in proportion to each 
other.

• Click Reset to restore the original effect settings.

4. Click  to close the options panel and apply your changes.

Modifying a PiP Effect or Object
A picture-in-picture effect allows you to insert an image, video or object 
onto an existing image or video clip in your movie, effectively 
overlaying a picture-in-picture within the existing clip. You can modify 
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the degree of transparency of the overlapping clip, as well as its 
position, motion and other properties using the PiP Designer.

Note: Whenever you adjust any of the options in the PiP Designer, a preview 
of the effect is instantly displayed for your convenience.

Modifying Objects
When you insert an object from the Objects Room into the PiP Track, it 
has all of the same properties as any other PiP photo or video. Objects 
can be resized, repositioned, and modified by adding shadows, chroma 
key effects, etc.

Some objects have pre-defined motion that can be modified or motion 
can be added to static objects. To modify objects as required, use the 
following procedures.

Modify a PiP Effect’s Size and Position
You can change both the size and the position of the media clip or 
object in a PiP effect. Resizing options are unrestricted. You can reduce 
the clip to miniature size or enlarge it to completely obscure the 
underlying media file.

To modify a PiP effect’s size and position, do this:
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1. Click the media clip or object in the PiP track, then click Modify. 
The PiP Designer window is displayed.

2. Modify the size and position in the preview window:
• Drag the PiP clip to a desired location over the underlying 

clip.

• Drag the edge of the PiP clip to a desired size. Check Keep 
aspect ratio to constrain the ratio of the length and width 
of the PiP clip. Uncheck this option to change the aspect 
ratio freely.

3. Click  to close the PiP Designer and apply your changes.

Add Chroma Key Effect to PiP Effect
You can add a chroma key effect by selecting a color within the picture 
or video clip to reveal the image or video "behind" it. In effect, the 
removed color becomes transparent.

To add a chroma key effect to a PiP effect, do this:

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed.
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2. Check off the Apply chroma key dialog and then click on the 

Chroma Key Settings button  to set the chroma key settings.

3. Using the eye-dropper, select the color within the photo or video 
that you want to become transparent. Use the zoom buttons for 
assistance in selecting the precise color.
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4. Use the Intensity slider to set the level of transparency for the 
chroma key.

5. Click  to close the PiP Designer and apply your changes.

Add a Shadow to a PiP Effect
You can add a shadow to the clip or object in a PIP effect. Available 
options allow you to change the shadow’s color and size, and add a 
transparency or blur effect.

To add a shadow to a PiP effect, do this:
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1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed..

2. Check off the Apply shadow dialog and then click on the Shadow 

Settings button  to set the shadow settings as follows:

Option Description

Distance Drag the slider to increase or decrease the 
distance between the shadow and the PiP 
effect.

Blur Drag the slider to increase or decrease the 
blur effect of the shadow.

Transparency Drag the slider to increase or decrease the 
transparency of the shadow.

Select color Click the eyedropper to open the Color 
dialog box, where you can select the color 
of the shadow.

Shadow direction Click a dimple to indicate the direction of 
the shadow.
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3. Click  to close the PiP Designer and apply your changes.

Add a Border to a PiP Effect
You can add a border around the clip or object in a PIP effect. Available 
options allow you to change the border’s color and size, and add a 
transparency or blur effect.

To change the border of a PiP effect, do this:

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed.

2. Check off the Apply border dialog and then click on the Border 

Settings button  to set the border settings as follows:

Option Description

Size Drag the slider to increase or decrease 
the size of the border.

Blur Drag the slider to increase or decrease 
the blur effect of the border.
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3. Click  to close the PiP Designer and apply your changes.

Add Frame to PiP Effect
The PiP Designer lets you add a frame around the PiP photo, video or 
object that acts like a cookie cutter. The frame will cut out the portion of 
the PiP photo, video or object, leaving a PiP effect in a creative shape.

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed

Transparency Drag the slider to increase or decrease 
the transparency of the border.

Uniform color Check to set the border in a single color. 
Click the eyedropper to open the Color 
dialog box, in which you can select a 
color.

Gradient color Check to apply a gradient color 
consisting of two colors that flow into 
each other. Use the Begin with and End 
with color eyedroppers to select the 
colors.

Begin with Click the eyedropper to open the Color 
dialog box, in which you can select the 
color at the beginning of the gradient.

End with Click the eyedropper to open the Color 
dialog box, in which you can select the 
color at the end of the gradient.

Gradient direction Click a dimple to indicate the direction of 
the gradient.

Option Description
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2. Select a frame style from the available list to apply to the PiP effect.

3. Click  to close the PiP Designer and apply your changes.

Setting PiP Effect Transparency
You can set the level of transparency of the PiP effect in the PiP 
Designer.

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed.

2. Use the Transparency slider to set your desired level of 
transparency for your effect.

3. Click  to close the PiP Designer and apply your changes.

Add Motion to a PiP Effect
You can add motion to a PIP image, video or object, allowing it to move 
across the screen. You can choose from a number of pre-defined 
motions or create your own custom PiP motion. You can also add a 
fade-in or fade-out effect to a PiP effect.
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Note: Some Objects have a pre-defined motion already applied. You can 
select another predefined motion for these object as described below. 

Add a Pre-defined Motion to a PiP Effect

To add a pre-defined motion to a PiP effect, do this:

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed.

2. Click on the Motion tab to display the PiP motion options.

3. Select a pre-defined motion from the available list.

4. Click  to close the PiP Designer and apply your changes.

Customize Rotation of a PiP Effect

To customize the rotation of a PiP effect, do this:

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed.
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2. Click on the Motion tab to display the PiP motion options.

3. Select a pre-defined motion from the available list to use as a 
template.

4. In the Rotation Settings section, enter in the degree of rotation 
you want the PiP to rotate in the available box.

5. Choose whether to rotate the PiP effect clockwise or counter 
clockwise by clicking on the corresponding button. A preview of 

the motion will be displayed in the preview window.
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6. Click  to close the PiP Designer and apply your changes.

Customize Motion of a PiP Effect

The PiP Designer uses position points to determine the location of the 
PiP effect at a point in time. By changing the location of position points, 
you can alter the path the PiP effect will take in its motion. The speed at 
which a PiP effect moves across the screen can also be controlled by a 
combination of positions points and the duration the PiP effect is given.

Note: Some Objects have predefined motion already applied. To modify its 
predefined motion, skip to step 4 in the below procedure.

To customize the motion of a PiP effect, do this:

1. Select the PiP clip that you want to modify, then click Modify. The 
PiP Designer window is displayed.

2. Click on the Motion tab to display the PiP motion options.

3. Select a pre-defined motion from the available list to use as a 
template.
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4. Drag an existing position point to a new location in the preview 
window. The PiP effect will move along the new path to get to the 

changed position point.

5. Drag the path line to alter the path the PiP effect will take to get to 
the position point.
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6. Use the slider to preview the movement of the PiP effect.

7. Click the Add position point button  to add a new position 
point where required.

8. Repeat steps 4 and 5 to customize the path of the PiP effect as 
required.

9. Click  to close the PiP Designer and apply your changes.
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Note: You can use the Remove potion point button to remove a 
highlighted position point, however their must be a minimum of two 
position points on the PiP effect motion path.

Add Fade-in and Fade-out to PiP Effect
You can have the PiP photo, video or object fade-in and out at the 
beginning and ending of its duration

To add fade-in and fade-out effect, do this:

1. Select the PiP clip or object that you want to modify, then click 
Modify. The PiP Designer window is displayed.

2. Click on the Motion tab to displayed the PiP motion options
3. Check of the Fade-in dialog to have the PiP Effect fade-in as it 

appears.

4. Check of the Fade-out dialog to have the PiP Effect fade-out as it 
disappears.

5. Click  to close the PiP Designer and apply your changes.

Modify a Title Effect
Using title effects allows you to add text to your movie - as a title at the 
beginning, an element during the main story or as credits at the very 
end. Besides changing the look of the text itself, you can also send the 
text running on a path across the screen. Title effects only affect the 
clips in the Master Video Track that appear within the title’s duration.

Title effects contain character presets, animation and background 
options, which you can modify to best suit your movie. All of these 
options are found in the Title Designer.

Note: For comic title effects you can modify both the text and the text 
bubble in the Title Designer, including its size, position, shadow effects, etc. 
The procedure for editing comic text bubbles, is the same as for modifying 
the text effects.
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Apply a Character Preset to a Title Effect
You can apply a defined character preset to a title effect. After you have 
applied the defined character preset you can go to font face, shadow or 
border settings to make changes to the title effect if required.

To apply a character preset to a title effect, do this:

1. Select a title effect in the Title Track and then click Modify. The 
Title Designer window is displayed.

2. Click Title Text tab and then click Character presets tab to open 
the Character presets tab if it is not already opened.
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3. Click on text in the preview screen that you would like to change 
and then choose a character preset from the available list by 
clicking on it. The selected text will change to the character preset.

4. Click  to close the Title Designer and apply your 
changes.

Customize a Title Effect’s Font Face
You can customize the font used in a title effect, including the size, 
color, font type used, weight, alignment, transparency and blur effect. 
Further tools aid in the precise positioning of the title on the screen and 
indicate the on-screen area that is safe for TV display.
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1. Select a title effect in the Title Track and then click Modify. The 
Title Designer window is displayed.

2. Click on the Title text tab and then on Font face settings tab to 
open the font face settings if it is not already opened.
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3. Set the text font face options that you want to apply

Option Description

Select a font type.

Set the font size.

Click to make the text bold.

Click to make text italicized.

Click to left-align text.

Click to center-align text.

Click to right-align text.

Click to undo any changes you make.

Click to redo any changes you make.

Click to bring selected text forward.

Click to send selected text backward.

Select the desired alignment for Title 
Effect object.

Click to insert a new title.
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Click to insert a new image.

Click to cut selected object.

Click to copy selected object.

Click to paste selected object.

Click to add/remove grid lines that can 
aid in the precise positioning of text on 
the screen. Grid lines do not appear 
when you preview or produce your 
movie.

Click to add/remove the TV Safe Zone 
outline, which represents the area in 
which video content from your movie 
is certain to appear on TV screens, 
which have a smaller display area than 
computer monitors. The TV Safe Zone 
outline does not appear when you 
preview or produce your movie.

Apply font face Check to apply the font face settings. 
Uncheck to remove the font face 
settings.

Blur Drag the slider to increase or decrease 
the blur effect of the font face.

Transparency Drag the slider to increase or decrease 
the transparency of the font face.

Option Description
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4. Click  to close the Title Designer and apply your 
changes.

Add a Shadow to a Title Effect
You can add a shadow around the text in a title effect. Available options 
allow you to change the shadow’s color and size and add a 
transparency or blur effect.

1. Select a title effect in the Title Track, then click Modify. The Title 
Designer window is displayed.

Uniform color Check to apply a solid font face color, 
which can be selected with the 
corresponding eye-dropper.

Gradient color Check to apply a gradient color 
consisting of two colors that flow into 
each other. Use the Begin with and End 
with color eyedroppers to select the 
colors.

Begin with Click the eyedropper to open the Color 
dialog box, in which you can select the 
color at the beginning of the gradient.

End with Click the eyedropper to open the Color 
dialog box, in which you can select the 
color at the end of the gradient.

Gradient direction Click a dimple to indicate the direction 
of the gradient.

Option Description
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2. Click the Title text tab and then click Font shadow settings tab to 
open the Shadow settings.

3. Set the text shadow options that you want to apply:

Option Description

Apply shadow Check to apply the shadow settings. 
Uncheck to remove the shadow settings.

Distance Drag the slider to increase or decrease the 
distance between the shadow and the 
font face.

Blur Drag the slider to increase or decrease the 
blur effect of the shadow.

Transparency Drag the slider to increase or decrease the 
transparency of the shadow.

Fill shadow Check to fill in the gap between the 
shadow and the font face.
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4. Click  to close the Title Designer and apply your 
changes.

Add a Border to a Title Effect
You can add a border around the text in a title effect. Available options 
allow you to change the border’s color and size and add a transparency 
or blur effect.

1. Select a title effect in the Title track, then click Modify. The Title 
Designer opens.

Select color Click the eyedropper to open the Color 
dialog box, where you can select shadow 
color.

Shadow direction Click a dimple to indicate the direction of 
the shadow.

Option Description
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2. Click the Title text tab and then click Border settings tab to open 
the Border settings.

3. Set the text border options that you want to apply:

Option Description

Apply border Check to apply the border settings. 
Uncheck to remove the border settings.

Size Drag the slider to increase or decrease 
the size of the border.

Blur Drag the slider to increase or decrease 
the blur effect of the border.

Transparency Drag the slider to increase or decrease 
the transparency of the border.

Uniform color Check to apply a solid border color, 
which can be selected with the 
corresponding eye-dropper.
153



CyberLink PowerDirector 6
4. Click  to close the Title Designer and apply your 
changes.

Apply Animation to a Title Effect
You can apply animations to a title effect, such as text movements or 
wipes. Animations can be applied to all the text objects in the title or 
just to individual text objects. You can apply the animation at the 
beginning or at the end of the effect, or both.

1. Select a title effect in the Title Track, then click Modify. The Title 
Designer opens.

Gradient color Check to apply a gradient color 
consisting of two colors that flow into 
each other. Use the Begin with and End 
with color eyedroppers to select the 
colors.

Begin with Click the eyedropper to open the Color 
dialog box, where you can select the 
color at the beginning of the gradient.

End with Click the eyedropper to open the Color 
dialog box, where you can select the 
color at the end of the gradient.

Gradient direction Click a dimple to indicate the direction 
of the gradient.

Option Description
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2. Click the Animation properties tab.

3. Select the text object you wish to animate in the Objects list or 
click on the object in the Preview window.

Note: Check Display the selected object only if you wish to only view 
the object you have selected when applying animations.

4. Click Begin Effect and select a starting animation effect from the 
available list.

5. Click OK to close the Begin Effect window.

6. Click End Effect and select an ending animation effect from the 
available list.

7. Click OK to close the End Effect window.
8. Preview your animation in the preview window

9. Click  to close the Title Designer and apply your 
changes.
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Apply Background Image to a Title Effect
You can apply your own background images to a title effect. The 
background image is applied to the entire title effect and will overlay 
the content from the Master Video Track.

1. Select a title effect in the Title Track, then click Modify. The Title 
Designer opens.

2. Click the Background properties tab.

3. Select the background you wish to use from the Background 
Image list.

• If you don’t see a background image you like you can use 

your own image. Click  to add a new image.
4. Preview your change in the preview window and click OK to 

confirm your change.
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Save Custom Title Effect Template
Any changes that you make to a title effect can be saved as a custom 
title effect template that can be applied to other title effects.

To save your customized title effect template, do this:

1. Edit the title effect template as required.

2. Click . The Save As Template dialog window will be 
displayed.

3. Enter a template name in the field provided.
4. Drag the slider to the time frame in the current title effect you 

want to set as a thumbnail. This thumbnail will be displayed in the 
Title Effect Library.

5. Click the OK button to save your custom template.
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Audio Mixing and Voice 
Overs

Your production’s audio can make or break your creation. Use the Audio 
Mixing Room to customize your audio levels or record a voice over to 
add narration to your movie production.

Splitting Audio from a Video Clip
To make it easier to work with the audio in a video clip you can split the 
audio from it, inserting it into the Voice Track. 

To split the audio from a video clip, do this:

1. Right-click on a video clip in the Timeline and select Split Audio.

2. Click the OK button in the Split Audio dialog window. The audio 
will be moved from the Master Video Track to the Voice Track.

Note: The Split Audio function does not extract the audio from the video 
clip as a separate file. To extract the audio from a video clip, see "Extracting 
Audio from a Video Clip" on page 53.

Change Audio Clip Volume Levels
Your movie production may contain audio in the Music and Voice 
Tracks, as well as in the video clips you have added. Since all of these 
tracks may have been recorded at different levels, the result could 
produce an overwhelming and confusing sound track. 

Using CyberLink PowerDirector’s Audio Mixing Room, the audio levels 
of all of these different tracks can be mixed to produce a more 
harmonious sound track for your movie. Audio levels can also be mixed 
inside the audio clips on the Music and Voice Tracks.
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In-Track Audio Mixing
You can change the level of volume at any point within an audio clip in 
the Timeline.

To change the volume level of an audio track in the Timeline, do this:

1. Select the clip you want to modify.

2. Click on the audio level line at the point where you want to change 
the audio level to set a volume key. Drag the volume key up to 
increase the volume or down to decrease the volume.

• Set levels at fewer volume keys along the track for a more 
subtle change in volume, or more volume keys for a more 
extreme change in volume.

• To remove a volume key, drag it outside the clip’s borders.

Mix Audio Levels in the Audio Mixing Room
Using the Audio Mixer in the Audio Mixing Room gives you very precise 
control over the volume levels of the audio clips in the workspace. The 
Audio Mixer contains audio mixing controls for the different audio 
tracks in the workspace. The Audio Mixing Room appears as follows:

To mix audio in the Audio Mixing Room, do this:

Audio mixing controls
159



CyberLink PowerDirector 6
1. Click . The Audio Mixing Room opens.

2. Click Play on the Preview window controls.
3. Use the sliders to mix the volume levels of the corresponding 

tracks.
• Use the vertical sliders to set volume keys to increase or 

decrease the volume of the track at a specific moment.

• Use the horizontal sliders to increase or decrease the 
volume of the entire track.

Add a Fade Effect to an Audio Clip
To add a fade-in/fade-out effect to an audio clip, do this:

1. Click . The Audio Mixing Room opens.

2. Click the button corresponding to the type of fade effect you want:

• Click  to add a fade-in effect.

• Click  to add a fade-out effect.

Restore an Audio Clip’s Volume Levels
If you are dissatisfied with the volume level of any audio clip after 
manually setting volume keys, you can easily restore the clip’s original 
volume level. To do this, right-click the track and select Restore to 
Original Volume Level. Any audio volume keys you have added are 
permanently removed.

Record a Voice-Over
The Voice-Over Recording Room contains controls for recording a 
narration from a microphone while watching a preview of your video 
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production. When you capture your narration, the audio track is 
automatically synchronized with the video portion.

To record a voice-over, do this:

1. Click  to open the Voice-Over Recording Room.

2. Set your voice-over options as follows:
• Select Device to select your audio device and input.

• Select Profile to set up the audio quality.
• Select Options to set a recording time limit or 3 second 

delay before recording begins to ensure you are ready to 
record.

3. Choose whether to set a fade-in or fade-out effect on the voice-
over.

• Click  to add a fade-in effect.

• Click  to add a fade-out effect.

4. Locate the point in your movie where you want to begin recording 
a voice-over. You may do this in one of the following ways:

Recording volume control

Record/Stop button

Recording options buttons

Fade-in/out buttons
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• Drag the Timeline slider. 

• Drag the preview window slider. 

• Use the playback buttons.

• Enter a timecode in the timecode box. 
5. Drag the Recording volume level slider to set the input volume 

level.

6. Click  to begin recording. Record your voice-over as you 

watch the video in the preview window.

7. Click  to stop recording.
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Chapters
Chapters are used to ease navigation of your finalized production when 
burned to a disc, allowing viewers to watch only the content they want 
or easily find their place if the disc was stopped before completion.

Note: If you choose not to include chapters, your movie will play 
automatically when the disc is inserted into a player.

Set Chapters
To set chapters, do this:

1. Click  to open the Chapter Room.

2. Set chapter points by doing one of the following:

• To set a chapter at the beginning of each video clip, click 

.

• To set chapters at fixed intervals, enter an interval (in 

minutes), then click .

• To set a specified number of chapters evenly on your disc, 
enter the number of chapters in the entry box, then click 

.
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• To set chapter points manually, navigate to a location on the 

timeline, then click .

• To remove a chapter point, select it and then click .

• Click  to remove all of the chapter points you have set.

Set Chapter Thumbnails
You can customize the thumbnail image for each of your chapters, 
which will be displayed in your menu. 

To set a chapter thumbnail, do this:

1. Select the chapter whose thumbnail you want to change.

2. Drag the timeline slider and navigate to the location of the new 
thumbnail image in the timeline. (Use the Preview window to 
preview your thumbnail image.)

3. Click  to set the chapter thumbnail to the new image.
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Add Subtitles
CyberLink PowerDirector lets you add subtitles to your movie 
production. Subtitles can be imported from a text file or added 
manually within the Subtitle Room.

Add a Subtitle
To add a subtitle to your movie production, do this:

1. Click the  button to open the Subtitle Room.

2. You can add a subtitle marker in one of two ways:
• Use the playback controls to locate the point where the 

dialogue that corresponds with the subtitle begins and 

then click the Add subtitle marker button .
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Note: Click on the stop button on the playback controls to mark the end 

point for the subtitle, or click  again to mark the next subtitle.

• Click the Add Subtitle button .

3. Double-click on the subtitle marker in the Timeline or in the 
Subtitle list view and then enter the text as required.

• Format the subtitle text as required by clicking the Format 

Subtitle button .

• To remove a subtitle, select the subtitle marker and then 

click the Remove subtitle button .
• To export your inputted subtitles and save them as an .SRT 

file, click .

Import Subtitles from a Text File
You can import subtitles from a text file in the .SRT or .TXT formats. This 
allows you to compose your subtitles outside the program or retrieve 
them from another source and import them into CyberLink 
PowerDirector.

Note: The following steps are instructions for the import of TXT files. When 
an SRT file is imported, the subtitles are created automatically in CyberLink 
PowerDirector.

To import subtitles from a text file, do this:

1. Click the  button to open the Subtitle Room.

2. Use the playback controls to play your video and then click the 

Add subtitle marker button  at the point where each piece of 
dialogue corresponds with each subtitle in the TXT file. 

3. Click on the stop button on the playback controls to mark the end 
point for the subtitles to be imported. CyberLink PowerDirector 
will create the subtitle entries.
 166



Chapter 3: Creating Your Story
4. Click on the Import Text File button .
5. Select the text file that you want to import and then click on the 

Open button. The text will be imported into the subtitle entries.

• Format the subtitle text as required by clicking the Format 

Subtitle button .

• To remove a subtitle, select the subtitle marker and then 

click the Remove subtitle button .

Syncing Subtitles with Dialogue
To ensure that the subtitles in your movie production sync with the 
video dialogue, CyberLink PowerDirector provides a number of options 
for specifying the location.

To set a starting time for a subtitle:

• enter a time code in the Starting Time column for the subtitle.
• position your cursor at the beginning of the subtitle marker on 

Subtitle Track and drag the front of the clip to the new position.

To set an ending time for a subtitle:

• enter a time code in the Ending Time column for the subtitle.
• position your cursor at the end of the subtitle marker on Subtitle 

Track and drag the end of the clip to the new position.
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Producing Your 
Movie

After your movie has been completed, you are ready to produce your movie. 
Producing a movie simply means compiling (or rendering) the separate elements 
it contains into a playable movie file. As your movie can be destined for many 
different uses, CyberLink PowerDirector has several options to produce movies 
suited for any need.

This chapter contains the following sections:

• "Viewing SVRT Information" on page 170

• "Production Mode" on page 171

• "Create a File" on page 174

• "Create a Streaming File" on page 190

• "Write Back to DV Tape" on page 196

• "Write Back to HDV Tape" on page 200

• "Uploading Video" on page 203

• "Batch Production" on page 208
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Viewing SVRT Information
SVRT (Smart Video Rendering Technology) is a proprietary rendering 
technology from CyberLink that recognizes which portions of a movie 
clip have been modified (and therefore require rendering during 
production), and which portions of a movie clip have not been changed 
(and thus can be skipped over during rendering). By viewing SVRT 
information, you can simulate the production process.

Note: For more information on SVRT, see "SVRT2: When Can I Use it?" on 
page 242.

To view how CyberLink PowerDirector uses SVRT in your current 
project, do this:

1. Click View > SVRT Information. The SVRT Info Room opens and 
the SVRT track appears on the timeline.

2. Select the profile you want to use to produce your movie, then 
click Update SVRT Info to view updated SVRT information. The 
colors that appear in the SVRT track designate how CyberLink 
PowerDirector uses SVRT for the related clip (or clip portion).

• Green: no rendering is required during production. 
• Blue: only video rendering is required.

• Yellow: only audio rendering is required.
• Red: both audio and video rendering is required.)
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Production Mode
When you click the  button, CyberLink PowerDirector 
enters the Produce Mode. Here you can compile your movie into a file 
that is ready for a variety of destinations, including burning to a disc or 
upload to the Internet.

Production Wizard
CyberLink PowerDirector uses the Production Wizard to assist you to 
finalize your production. When you click the Produce button, the 
Production Wizard is displayed as follows:

Production mode buttons

Information display areas

Preview window
Provides playback controls to preview 
your movie
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The Production Wizard is a simple interface that makes movie 
production easy.

Note: Before producing your movie, make sure that all of your video 
clips have the same interlacing format. This is an extremely important step to 
take before production, as it can drastically affect final video quality! If you 
produce your movie and find the video quality unsatisfactory, verify that the 
interlacing format of all of your video clips is the same. If your clips have 
different interlacing formats, set them all to the same format, then produce 
your movie again. For more information, see "Set a Video Clip’s Interlacing 
Format" on page 111.

The first window of the Production Wizard contains a preview window, 
a visual display of your hard disk space, and five buttons corresponding 
to the five production options available in The Production Wizard. 
These are described below:

Button Description

Create a File: Allows you to create a movie 
production that you can then watch on your 
computer. See "Create a File" on page 174.

Create a Streaming File: Allows you to create a 
movie production that you can then stream over 
the Internet. See "Create a Streaming File" on page 
190.

Write Back to DV Tape: Allows you to create a 
movie production that you can then write back to 
DV tape. See "Write Back to DV Tape" on page 196.

Write Back to HDV Tape: Allows you to create a 
movie production that you can then write back to 
HDV tape. See "Write Back to HDV Tape" on page 
200.
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Upload to YouTube®: Allows you to upload your 
video production to the Internet to share with the 
world. See "Uploading Video to YouTube" on page 
203.

Upload to MediaMax®, powered by Streamload: 
Allows you to upload your video production to the 
MediaMax to share with family and friends. See 
"Uploading Video to MediaMax" on page 206.

Button Description
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Create a File
You can produce your movie as a video file that you can watch on your 
computer, burn to disc or output to a PSP. CyberLink PowerDirector 
allows you to create files in AVI, MPEG-1, MPEG-2, DivX or MPEG-4 
format.

Note: The type of files that can be created depend on the version of 
CyberLink PowerDirector that is installed on your computer. Please see the 
Readme for information on the file types your version supports 

Create/Modify a Video File Profile
Before producing a video file, you may want to create a new profile or 
modify an existing profile for the file type you are creating. Profile 
Settings let you configure video and audio quality, bitrate compression, 
etc. for each file to customize the outputted file for advanced user 
requirements.

If you want to create a video file without modifying the profile settings, 
see "Creating a Video File" on page 187.

The following section outlines the procedures for creating and 
modifying profiles for each of the available video file types.

Modify DV-AVI Profile Settings
When creating a DV-AVI file, modify the Profile Settings for a DV-AVI file 
as follows:
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1. Click on the Settings button for DV-AVI files to display the DV-AVI 
Production Profile Settings window. 

• Select either Type I or Type II when creating an AVI file. For 
more information see "AVI Formats" on page 244.

• Select High Quality or Medium Quality for the audio 
quality, either 48k or 38k.

2. Click on OK to save your profile settings.

Modify Windows AVI Profile Settings
When creating a Windows AVI file, modify the Profile Settings for a 
Windows AVI file as follows:

1. Select the name of the profile you want to modify from the drop-
down.

2. Click on the Settings button for Windows AVI files to display the 
AVI Profile Settings window: 

• Compression codec: Select a codec from the drop-down 
list.
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• Key frame: This field, when available, allows you to set the 
number of key frames in your video, but this number cannot 
be set for most codecs. 

• Data rate: Select a data rate from the drop-down list.

• Composition: Select the media type to be compressed in 
your final movie production: Video and audio, Video only, 
or Audio only.

• The Codec Settings... and About buttons open dialog 
boxes with options and information about the individual 
compression/decompression schemes.

• Better compression/Better quality: Drag the slider to 
select a setting between smaller production file size and 
better video quality.

3. Click the Video/Audio Settings tab and set your options, if 
necessary:

• Frame(s): Select a frame rate from the drop-down list.
• Video size: Select a video display size from the drop-down 

list.

• Colors: Select a color scheme from the drop-down list.
• Format: Select an audio format from the drop-down list.
• Attributes: Select audio attributes from the drop-down list.

4. Click on OK to save your profile settings.
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Modify DivX Profile Settings
When creating a DivX file, modify the Profile Settings for a DivX file as 
follows:

1. Click on the Settings button for DivX files to display the DivX 
Profile Settings window. 

• Compression codec: Select a codec from the drop-down 
list.

• Key frame: This field, when available, allows you to set the 
number of key frames in your video, but this number cannot 
be set for most codecs. 

• Data rate: Select a data rate from the drop-down list.

• Composition: Select the media type to be compressed in 
your final movie production: Video and audio, Video only, 
or Audio only.

• The Codec Settings... and About buttons open dialog 
boxes with options and information about the individual 
compression/decompression schemes.

• Better compression/Better quality: Drag the slider to 
select a setting between smaller production file size and 
better video quality.
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2. Click the Video/Audio Settings tab and set your options, if 
necessary:

• Frame(s): Select a frame rate from the drop-down list.
• Video size: Select a video display size from the drop-down 

list.
• Colors: Select a color scheme from the drop-down list.

• Format: Select an audio format from the drop-down list.
• Attributes: Select audio attributes from the drop-down list.

3. Click on OK to save your profile settings.

Create a New MPEG-1 Profile
MPEG production profiles can be used when you produce a movie for a 
disc or when you create an MPEG-1. You can create custom production 
profiles or edit an existing one if none of the available profiles suit your 
specific production requirements.

When creating a MPEG-1 file, create a custom MPEG-1 production 
profile as follows:
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1. Click on the New button for MPEG-1 to display the Profile Setup 
window.

2. Enter a new profile name.
3. Click the Video tab and modify the video options, if necessary:

• Video size: Select a video display size from the drop-down 
list.

• Video compression bitrate: Drag the slider to increase or 
decrease video bitrate. An increased bitrate (set by 
dragging the slider to the right) results in a larger file size 
and increased production time.

• Smoothing: Check to produce a softer video image. Only 
use this option if it was not used during capture, as it can 
result in slightly blurred video quality.
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• Deinterlacing: Check to create deinterlaced video. 
Deinterlacing improves the quality of interlaced video when 
displayed on a computer monitor, but does may degrade 
video quality in other cases.

• Noise removal: Check to remove video artefacts. Only use 
this option if it was not used during capture, as it can result 
in slightly blurred video quality.

• High speed/High quality: Drag the slider to select an 
acceptable setting between faster production speed with 
lower video quality and higher video quality with slower 
production speed.

4. Click the Audio tab and modify the audio option, if necessary:

• Audio compression: Select the audio compression type 
from the drop-down list.

• Audio compression rate: Select a rate from the drop-down 
list. A higher rate yields better audio quality, but results in a 
larger file and increased production time.

5. Click OK to close the dialog box.

• To edit a custom production profile, click  and edit the 
necessary information.

• To delete a profile, click . A warning message appears, 
asking if you want to delete the profile. Click Yes. The profile 
is deleted.
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Create a New MPEG-2 Profile
MPEG production profiles can be used when you produce a movie for a 
disc or when you create an MPEG-2. You can create custom production 
profiles or edit an existing one if none of the available profiles suit your 
specific production requirements.

When creating a MPEG-2 file, create a custom MPEG-2 production 
profile as follows:

1. Select the name of the profile you want to use as a template from 
the Profile name/Quality drop-down.

2. Click on the New button for MPEG-2 to display the Profile Setup 
window.

3. Enter a new profile name.
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4. Click the Video tab and modify the video options, if necessary:

• Resolution: Select a video resolution from the drop-down list.
• Rate Control: Rate control allows you to customize the 

video bitrate. An increased bitrate results in a larger file size 
and increased production time.

• Smoothing: Check to produce a softer video image. Only 
use this option if it was not used during capture, as it can 
result in slightly blurred video quality.

• Noise removal: Check to remove video artefacts. Only use 
this option if it was not used during capture, as it can result 
in slightly blurred video quality.

• Speed/Quality Indicator: Drag the slider to select an 
acceptable setting between faster production speed with 
lower video quality and higher video quality with slower 
production speed.
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5. Click the Audio tab and modify the audio option, if necessary:

• Audio Compression: select an audio compression type 
from the drop-down list. 

• Audio Compression Rate: Select a rate from the drop-
down list. A higher rate yields better audio quality, but 
results in a larger file and increased production time.

6. Click OK to close the dialog box.

• To edit a custom production profile, click  and edit the 
necessary information.

• To delete a profile, click . A warning message appears, 
asking if you want to delete the profile. Click Yes. The profile 
is deleted.
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Create a New MPEG-4 Profile
MPEG production profiles can be used when you produce a movie for a 
disc or when you create an MPEG-4 to output to a PSP or iPod. You can 
create custom production profiles or edit an existing one if none of the 
available profiles suit your specific production requirements.

When creating a MPEG-4 file, create a custom MPEG-4 production 
profile as follows:

1. Select the name of the profile you want to use as a template from 
the Profile name/Quality drop-down.

2. Click on the New button for MPEG-4 to display the Profile Setup 
window.

3. Enter a new profile name.
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4. Click the Video tab and modify the video options, if necessary:

• Resolution: Select a video resolution from the drop-down 
list.

• Rate control: Set the rate control settings for the MPEG-4 
file.

• Entropy coding: Select an entropy coding scheme to 
compress digital data.

• Rate control: Rate control allows you to customize the 
video bitrate. An increased bitrate results in a larger file size 
and increased production time.

• High speed/High quality: Drag the slider to select an 
acceptable setting between faster production speed with 
lower video quality and higher video quality with slower 
production speed.
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5. Click the Audio tab and modify the audio option, if necessary:

• Audio compression: Select the audio compression type 
from the drop-down list.

• Audio compression rate: Select a rate from the drop-down 
list. A higher rate yields better audio quality, but results in a 
larger file and increased production time.

6. Click OK to close the dialog box.

• To edit a custom production profile, click  and edit the 
necessary information.

• To delete a profile, click . A warning message appears, 
asking if you want to delete the profile. Click Yes. The profile 
is deleted.

Note: You need to have the extra MPEG-4 pack installed to activate MPEG-4 
support.
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Creating a Video File
To produce a video file that you can watch on your computer, do this:

1. Click  to open the Production Wizard.

2. Click  and then . The file production options 
appear on the page.

3. Select the video file format you want to create by clicking the 
corresponding button.

Note: Depending on the file format you selected, the following options will 
vary.

4. Select the country the video file will be played in from the 
Country/video format of disc drop-down, if required.

5. Select the Profile Type from the drop-down if required.
• Profile Type determines the type of that file format that will 

be created. For AVI files select either a Windows AVI or DV-
AVI or select a default of custom profile for MPEG files.
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6. Select the Profile Name from the drop-down menu as required.
• Profile Name could be a customized profile, or the TV 

display format, i.e. either NTSC or PAL for DV-AVI files. See 
"Create/Modify a Video File Profile" on page 174 for more 
information.

7. To review your production settings, click . A dialog box 
opens, where you can verify the profile’s details.

8. Click  to set the CLVS settings.
• Apply CyberLink VirtualSpeaker to enhance background 

music: Check this option to enable CyberLink 
VirtualSpeaker to enhance background music. Choose 
between Living Room, Theater, and Stadium. 

9. Use SVRT to save rendering time: Keep this option checked 
(when it is enabled) to reduce production time. For more 
information on SVRT, see "SVRT2: When Can I Use it?" on page 242.

10. Click . The production details appear on the page. 
Verify that these details are correct.
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• You can change the video file name and destination folder. 
To do this, click , then enter a new name or locate a new 
folder.

• To ensure that all of your video clips have the same 
interlacing format, click Scan source video clips and set 
field order.

11. Click . The production process begins. This process may 
take a few minutes.

• To stop the production process before completion, click 

.

• To return to Edit mode after production is complete, click 

.
• To preview your movie during production, select Enable 

preview during production. Selecting this option will 
however increase the time required to finalize your 
production.
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Create a Streaming File
You can produce your movie as a video file that can be stored on a 
server for streaming over the Internet. CyberLink PowerDirector allows 
you to create files in WMV, RealVideo or QuickTime Movie format. 

Create/Modify a Streaming File 
Profile

Before producing a streaming file, you may want to create a new profile 
or modify an existing profile for the file type you are creating. Profile 
Settings let you configure video and audio quality, compression 
settings, etc. for each file to customize the outputted file for advanced 
user requirements.

If you want to create a streaming file without modifying the profile 
settings, see "Create a File for Streaming" on page 193.

The following section outlines the procedures for creating and 
modifying profiles for each of the available streaming file types.

Create a New RealVideo Profile
When producing a RealVideo streaming file, create a custom 
production profile for RealVideo files as follows:

1. Select the name of the profile you want to use as a template from 
the drop-down.
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2. Click on the New button. The Profile Setup window is displayed.

3. Enter a new profile name.
4. Click the Settings tab and modify the Video, Audio and Target 

Audience settings as follows:

• Video setting: Select a video quality and video size from 
the drop-down lists. Larger quality and sizes will result in a 
larger streaming file
191



CyberLink PowerDirector 6
• Audio setting: Select the appropriate audio setting from 
the drop-down list.

•  Target audience: Select the type of download speed your 
target audience will most likely be using. 

5. Click OK to close the Profile Settings window.

• To edit a custom production profile, click  and edit the 
necessary information.

• To delete a profile, click . A warning message appears, 
asking if you want to delete the profile. Click Yes. The profile 
is deleted.

Create a New QuickTime Profile
When producing a QuickTime streaming file, create a custom 
production profile for QuickTime files as follows:

1. Select the name of the profile you want to use as a template from 
the drop-down.

2. Click on the New button. The Profile Setup dialog box appears.

3. Enter a new profile name.
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4. Click the Video Compressor tab and set your Video Setting 
options:

• Compressor component: Select a compression scheme 
display size from the drop-down list.

• Video size: Select a video display size from the drop-down 
list.

• Video type: Select a video codec type from the drop-down 
list.

• Video quality: Select a video quality from the drop-down 
list.

• Key frame rate: Use the arrows to set a key frame rate 
(between 0 and 32).

5. Click OK to close the dialog box.

• To edit a custom production profile, click  and edit the 
necessary information.

• To delete a profile, click . A warning message appears, 
asking if you want to delete the profile. Click Yes. The profile 
is deleted.

Create a File for Streaming
To produce a movie file that you can stream over the Internet, do this:
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1. Click  to open the Production Wizard.

2. Click  and then on . The Streaming file 
production options page is displayed.

3. Select the movie file format you want to produce.

4. Select the movie profile setting that suits your production needs. 
See "Create/Modify a Streaming File Profile" on page 190 for 
information on creating or modifying profiles.

5. Click . The production details appear on the page. 
Verify that these details are correct.

• You can change the video file name and destination folder. 
To do this, click , then enter a new name or locate a new 
folder.

• To ensure that all of your video clips have the same 
interlacing format, click Scan source video clips and set 
field order.

Note: This is an extremely important step to take before producing your 
final movie, as it can drastically affect final video quality!
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6. Click . The production process begins. This process may 
take a few minutes.

• To stop the production process before completion, click 

.
• To return to the Edit mode after the production is complete, 

click .
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Write Back to DV Tape
You may want to produce your movie and then write it back to DV tape. 
This allows you to store your movie in a convenient, digital format that 
can easily be imported into another computer for further editing.

To produce a movie that you can write back to DV tape, do this:

1. Click  to open the Production Wizard.

2. Click  and then on . The options for writing to 
disc appear on the page.

3. Click on the Settings button  to customize the settings for 
writing back to a DV tape if required. 
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4. Click . The production details appear on the page. 
Verify that these details are correct.

• You can change the video file name and destination folder. 
To do this, click , then enter a new name or locate a new 
folder.

5. Click . The production process begins. This process may 
take a few minutes

• To stop the production process before completion, click 

.
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6. When production is complete, the Write to DV Tape dialog box 
opens.

7. Locate the position at which you would like to begin writing to 
tape. You may do this in one of the following ways:

• Use the playback buttons.
• Drag the time slider.

• Enter a timecode in the timecode box. 
8. Your produced movie file appears in a list in the window.

• Click  to add new files to the file list. Select a file and click 

 to remove it from the file list.

• Select a file then click  to bring it closer to the 

beginning of your movie when writing to tape. Click  
to move it toward the end.

• To ensure that all of your video clips have the same 
interlacing format, click Scan source video clips and set 
field order.

Note: This is an extremely important step to take before producing your 
final movie, as it can drastically affect final video quality!
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9. Click . A message appears asking you to ensure your 
tape is at correct location and not write-protected. (Writing back 
to tape overwrite any content currently on the tape at that 
position.)

10. Click Yes. Writing begins.
• Click Abort to stop.
• If successful, a confirmation message appears.

11. Click OK.
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Write Back to HDV Tape
You may want to produce your movie and then write it back to HDV 
tape. This allows you to store your movie in high definition format that 
can easily be imported into another computer for further editing.

To produce a movie that you can write back to HDV tape, do this:

Note: You must manually locate the position on your HDV camcorder tape 
where you want to write back your content to before proceeding.

1. Click  to open the Production Wizard.

2. Click  and then on . The options for writing to 
disc appear on the page.
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3. Click . The production details appear on the page. 
Verify that these details are correct.

• You can change the video file name and destination folder. 
To do this, click , then enter a new name or locate a new 
folder.

4. Click . The production process begins. This process may 
take a few minutes

• To stop the production process before completion, click 

.
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5. When production is complete, a dialog is displayed indicating that 
CyberLink PowerDirector is writing your production to the HDV 
tape.

• Click Abort to stop.
• If successful, a confirmation message appears.

6. To return to Edit mode after writing back to HDV camcorder is 

complete, click .
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Uploading Video
CyberLink PowerDirector makes it easy to upload your created movie 
productions to the Internet. In just a few steps, you can upload your 
production from within CyberLink PowerDirector to either YouTube® or 
MediaMax®.

Uploading Video to YouTube
To upload your video to YouTube®, do this:

1. Click  to open the Production Wizard.

2. Click  and then on . The sign in and 

authorization options for YouTube appear on the page.

3. To sign into YouTube do one of the following:
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• If you already have a YouTube account, click the 
authorization button to login and authorize CyberLink 
PowerDirector to use your account to upload content.

• If do not have a YouTube account, click the Sign up to 
YouTube button to sign up for a new account and then 
authorize CyberLink PowerDirector to use your account to 
upload content.

4. Click . The video details window is displayed. Enter the 
details about your video as follows:

• Title: Enter the title of your movie production.

• Description: Enter in a short description of your movie 
production.

• Tag: Enter in several tags, separated by a space, that 
describe your video. Tags are keywords that people will 
search for on the YouTube site.

• Video channel: Select the relevant video channel type from 
the available list.

• Broadcast: Select whether to share your video with the 
world or mark it as private.
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5. Click . The copyright disclaimer window is displayed. 
Select your desired profile quality from the drop down.

6. Read and confirm the copyright information by selecting the 
corresponding check box.

7. Click  and then click . CyberLink 
PowerDirector will produce and then upload your video to 
YouTube. This process may take a few minutes

• To ensure that all of your video clips have the same 
interlacing format, click Scan source video clips and set 
field order.

• To stop the production process before completion, click 

.

• To return to Edit mode after production is complete, click 

.
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Uploading Video to MediaMax
To upload your video to MediaMax®, do this:

1. Click  to open the Production Wizard.

2. Click  and then on . The sign in options for 

MediaMax appear on the page.

3. To sign into MediaMax do one of the following:

• If you already have a MediaMax account, enter in your user 
name and password.

• If do not have a MediaMax account, click the Sign up to 
MediaMax button to sign up for a new account.

4. Click . The copyright disclaimer window is displayed. 
The copyright disclaimer window is displayed. Select your desired 
profile quality from the drop down.
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5. Read and confirm the copyright information by selecting the 
corresponding check box.

6. Click  and then click . CyberLink 
PowerDirector will produce and then upload your video to 
YouTube. This process may take a few minutes

• To ensure that all of your video clips have the same 
interlacing format, click Scan source video clips and set 
field order.

• To stop the production process before completion, click 

.
• To return to Edit mode after production is complete, click 

.
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Batch Production
You can produce multiple created movie projects at one time in 
CyberLink PowerDirector using the Batch Produce feature. 

To perform a batch production, do this:

1. In the File menu, click File > Batch Produce... The Batch Produce 
window will be displayed.

2. Click on the Add Task button .

3. Navigate to the location of your created projects and then select a 
CyberLink PowerDirector project file (.pds) you want to produce.

4. Click the Open button. The selected project will be displayed in 
the Batch Produce window.

5. Click the Edit Task button  and configure the following 
production settings:

• Set the Output path of the outputted file.
• Select the Production type (file or streaming file) for the 

file.
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• Select the Media file format you want to output the movie 
project as (AVI, MPEG, RealVideo, QuickTime, etc.) from the 
drop down list.

• Select the Profile type from the drop down list.

• Select the Profile name/quality from the drop down list. 
See "Create/Modify a Video File Profile" on page 174 or 
"Create/Modify a Streaming File Profile" on page 190 for 
more information on profiles.

• Click  to set the CLVS settings. Apply CyberLink 
VirtualSpeaker to enhance background music: Check this 
option to enable CyberLink VirtualSpeaker to enhance 
background music. Choose between Living Room, Theater, 
and Stadium.

• Click  to return to the Batch Produce window.

6. Repeat steps 2 through 5 for each project you want to produce.

• Click  to remove a project from the batch 
production.

• Click  to preview a project/movie in the Media 
Viewer window.

7. When you have selected all the files you want to produce, click 

. CyberLink PowerDirector will produce all the selected 

files.
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Creating Discs

After your movie production has been completed, you can create a video disc to 
play your video on a DVD or other disc player. You can burn your movie onto CD 
or DVD discs in three simple steps. Integrated authoring allows to you view your 
movie in the living room instantly after you have produced your movie. You will 
never have to launch another program again to create a video disc.

This chapter contains the following sections:

• "Create Disc Mode" on page 212

• "Customize Your Disc’s Menu Page" on page 213

• "Burn to Disc" on page 227
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Create Disc Mode
When you click the  button, CyberLink PowerDirector 
enters the Create Disc mode, where you can burn your movie onto a 
VCD or DVD disc. In Create Disc mode, the program appears as follows:

The opening window contains an author/preview windows on the 
right, a list of options to customize your disc’s menu page, and three 
buttons on the bottom to view the disc summary, change your disc 
preference, and initiate the burning process.

Author/Preview windows

Create Disc Mode buttons

Customize Menu options
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Customize Your Disc’s Menu 
Page

Before you burn your movie to a disc, you should first create a menu for 
navigating around your disc. The Customize Menu pane gives you 
complete creative control over the look of your menu page. You can 
modify the appearance of the menu’s buttons, text and overall layout.

Select a Menu Page Style
CyberLink PowerDirector provides a number of menu page style 
templates that might suit the theme of your video production. You can 
also use these themes as a template when customizing your menu in 
the Menu Designer.

The menu page templates can be divided into two categories:

• menu templates with clickable chapter thumbnail buttons
• menu templates with clickable chapter text. 

To select a menu page style template, do this:

1. On the Style tab, select a style category from the drop-down list, or 
select All to show all styles.

2. Select a style template that you want to use by clicking on the 
thumbnail. It will automatically be applied to the Preview window.

Specify the Number of Buttons Per 
Menu Page

Menu buttons are clickable chapter thumbnails that can be customized 
in the Menu Designer. First, you must specify the number of menu 
buttons you want displayed on each menu page.

To specify the number of buttons per menu page, do this:
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1. Select the Menu Buttons tab.

2. Select the number of buttons you want per menu page. It will 
automatically be applied to the Preview window.

Note: If you selected a menu template that uses clickable chapter text, the 
menu buttons feature is disabled.

Using the Menu Designer
The Menu Designer lets you customize a selected disc menu style or 
create your own menu style. 

To use the Menu Designer to customize your menu, click on the Menu 

Designer button .
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The Menu Designer includes the following options for customizing your 
menu:

Option Description

Customize your menu text.

Set object effects in the menu.

Customize and set button effects and style.

Click to enter disc menu edit mode.

Click to preview your created menu.

Add additional text, images or buttons to 
the menu page.

Use to align text, buttons and other 
objects on the menu page.

Click to cut selected object.

Click to copy selected object.

Click to paste selected object.

Click this button to import a background 
image for your disc menu.

Click this button to add a video effect to 
your disc menu.

Click this button to add background music 
to your disc menu.
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Click this button to toggle between button 
rectangle/free form modes.

Click to undo any changes you make.

Click to redo any changes you make.

Click to send selected object backward.

Click to bring selected object forward.

Click to add/remove grid lines that can aid 
in the precise positioning of text on the 
screen. Grid lines do not appear on the 
outputted menu.

Click to add/remove the TV Safe Zone 
outline, which represents the area in which 
content from your menu is certain to 
appear on TV screens, which have a 
smaller display area than computer 
monitors. The TV Safe Zone outline does 
not appear on the outputted menu.

Click to save your customized menu style 
as a template that can be reused. 

Format the font style of the chapter 
number on disc menu.

Option Description
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Modify Menu Text
To edit text that appears on the menu page, including clickable chapter 
text, double-click it in the Menu Designer, and then enter the new text.

Note: Make sure you are in the Edit mode.

Apply a Character Preset to Menu Text
You can apply a pre-defined character preset for the menu text. After 
you have applied the pre-defined character preset you can go to font 
face, shadow, or border settings to make changes to the title effect if 
required.

The procedure for applying a character preset to menu text is the same 
as applying a character preset to title effect text. See step 2 in "Apply a 
Character Preset to a Title Effect" on page 145 for detailed information 
on applying a character preset to menu text.

Customize Menu Text Font Face
You can customize the font used in menu text, including the size, color, 
font type used, weight, alignment, transparency and blur effect. Further 
tools aid in the precise positioning of the title on the screen and 
indicate the on-screen area that is safe for TV display.

The procedure for customizing a menu’s text font face is the same as 
modifying text for a title effect. See step 2 in "Customize a Title Effect’s 
Font Face" on page 146 for detailed information on customizing menu 
text font face.

Add a Shadow to Menu Text
You can add a shadow around the text in the menu. Available options 
allow you to change the shadow’s color and size and add a 
transparency or blur effect.

The procedure for adding a shadow to menu text is the same as adding 
a shadow to title effect text. See step 2 in "Add a Shadow to a Title 
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Effect" on page 150 for detailed information on adding a shadow to 
menu text.

Add a Border to Menu Text
You can add a border around the text in the menu text. Available 
options allow you to change the border’s color and size and add a 
transparency or blur effect.

The procedure for adding a border to menu text is the same as adding a 
border to title effect text. See step 2 in "Add a Border to a Title Effect" on 
page 152 for detailed information on adding a border to menu text.

Set Object Effects
Use the Set Object Effects tab in the Menu Designer to customize all of 
your menus effects. The tab lists all of the current objects on your menu, 
including menu buttons, navigation buttons and text. 

To set the object effects, click on the Set Objects Effects tab in the 
Menu Designer.
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When you select an item in the Objects list, the object will be 
highlighted in the preview window. Once highlighted, the objects can 
be easily edited, resized, reshaped or moved around the disc menu to a 
desired location.

Note: When creating a menu with clickable chapter text, use the Set Object 
Effects tab to easily select, edit and position the clickable text objects in the 
desired position.

• Select Display the selected object only to only display the 
selected object while setting the effects.

• Select Display chapter number to display the inserted chapter 
numbers in your disc menu.

Set Button Effects
You can customize your menu and navigation buttons for your disc 
menu in the Menu Designer, by selecting a button frame, setting 
button position or setting a button highlight style.

Note: If you selected a menu template that uses clickable chapter text, you 
can only customize the menu’s navigation buttons. 
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To set the object effects, click on the Set Button Effects tab in the 
Menu Designer.

Select a Button Frame Style

To select a button frame style, do this:

1. Click on .

2. Select the button frame style you want to use from the list. It will 
automatically be applied to the Preview window.

Select a Button Alignment

To select a button alignment, do this:

1. Click on .

2. Select the number of buttons to display on the menu page from 
the drop-down list.

3. Select a button layout style from the list. It will automatically be 
applied to the Preview window.
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Select a Navigation Button Style

To select a navigation button style, do this:

1. Click on .

2. Select the navigation button style you want to use from the list. It 
will automatically be applied to the Preview window.

Select a Button Highlight Style

To select a button highlight style, do this:

1. Click on .

2. Select the button highlight style you want to use from the list. It 
will automatically be applied to the Preview window.

Replace Background Image
To replace the background image in your disc menu, do this:

1. In the Menu Designer, click on the Replace background image 

button .

2. Select the new image you want to use as the background image.

3. Click on the Open button to replace the background image.

Select a Video Effect
To select a video effect for your disc menu, do this:

1. In the Menu Designer, click on the Select a video effect button 

.

2. Select a video effect from the available list.
• A preview of each effect is displayed in the preview window.
• Use the available effect options to customize the video effect 

settings.
3.  Click on OK to apply the effect to your menu.
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Set Background Music
You can add an audio file as background music in your disc menu.

To add background music, do this:

1. Click  in the Author mode on the Disc Menu main page.

2. The Choose Menu Background Music dialog box opens.

3. Click  to open an audio track. You may edit the audio file 
you have selected. The following options are available, if desired:

• Select a fade in/out option.
• Select to auto repeat the audio file.
• Select whether to apply music to all pages.
• Trim the audio file using the sliders on the trim bar.
• Adjust the volume.

4. Click OK. The audio track appears in the Background music box.

• To remove the audio track, click .

• To add background music from Magic Music, click . The 
procedure is the same as Magic Music tool. See "Magic Music" on 
page 128 for more information.
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Set a First Play Video Clip
A clip designated as first play is the initial sequence that plays as soon 
as a disc is inserted into a computer for play, and before the menu page 
appears. No navigation buttons are available during the first play, and 
viewers cannot fast forward past this segment. In a professional 
production, first play typically consists of a copyright notice or warning. 
However, you may prefer to use a personal introduction or other video 
clip instead.

• To set a clip as first play, click  and select the video file that 
you want.

• Click  to remove the file set as first play.

• Click  to preview the first play video.

View a Summary of Your Disc

To view a detailed summary of your disc, click . The Summary 
dialog box opens listing the System Information and Production 
Information.
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Modify Your Create Disc Preference

Click  to modify your Create Disc Preference.

The following options are available under the Disc Format tab:

• Disc format: Select the disc format you will be using to burn your 
movie.

• Disc capacity (DVD only): Select the disc capacity of your DVD 
disc.

• Video quality (DVD only): Select a video quality for your disc: 
DVD LP (Long Play), DVD SP (Standard Play), DVD HQ (High 
Quality), or Smart Fit. The video quality settings offer different bit 
rates, resulting in files of different size. The higher the quality of 
the video, the larger the resulting file and the shorter the length 
of video that can fit onto a disc. Further, more CPU power is 
required for rendering higher quality video. The Smart Fit option 
automatically adjusts the bit rate to the best quality video file 
that fits exactly to the capacity of the disc you are using.

• Audio type: The different audio types are as follows: LPCM is an 
uncompressed audio format. Dolby Digital audio uses the Dolby 
Digital Consumer Encoder format. MPEG audio uses the MPEG-1 
audio compression format. (This audio format may have 
compatibility issues in NTSC.)
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Note: The video quality and audio type options that are available depend on 
the disc format that you have selected.

The following options are available under the Menu tab:

• Add thumbnail index: Check this option to add a thumbnail 
index to the menu.

• Enable video thumbnail: Check to allow chapter thumbnails to 
display video on the disc’s menu. If you select this option, you 
can limit the length of video that displays by entering a value for 
the User-defined motion menu duration option.

• Default menu style: Specify your favorite style (.fl file) as the 
style for each new CyberLink PowerDirector project.

The following option is available under the Audio tab:

• Apply CyberLink VirtualSpeaker to enhance background 
music: Check this option to enable CyberLink VirtualSpeaker to 
enhance background music. Choose between Living Room, 
Theater, and Stadium.
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Preview Your Disc’s Menu Page
Click Preview to preview your menu page. Click a button to preview the 
chapter associated with the button. Use the playback buttons to 
control the preview.

• Click Author to return to the Author mode.
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Burn to Disc
After you have acquired your media, assembled your story, edited your 
clips, added audio and visual effects, and customized the layout and 
look of your disc, then it’s time to finalize your production.

CyberLink PowerDirector offers several methods to finalize your 
production, which are useful under different circumstances. You can 
burn your production to disc as the last step in your movie production 
process, save your production as a disc image for later burning, or 
create a DVD folder to organize your media files on your hard drive. 
Depending on your burning drive and disc type, one or more of these 
options may be available simultaneously.

CyberLink PowerDirector supports the following DISC formats for 
burning:

• DVD: DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM
• VCD/SVCD: CD-R, CD-RW

Note: See "Modify Your Create Disc Preference" on page 224 for information 
on selecting your disc burning type.

Set Your Burning Configuration
Before you burn to disc for the first time, set your burning configuration 
on the Burn window. After you set this configuration, CyberLink 
PowerDirector uses the same configuration each time you burn until 
you change the settings.
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To set your burning configuration, do this:

1. Click  to open the Burn window.

2. Click . The Burning Configuration window opens.

3. Select your recording drive.
4. Select a recording speed.

• The Include buffer under-run protection option ensures that 
your drive writes without errors when your hard drive is busy or 
system resources are low.

5. Click OK to set your configuration and return to the Burn window.
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Burn Your Movie to Disc
Burning your movie to disc is the final stage of the create disc process. 
Once your disc is burned, you will be able to play it on a disc player to 
share with your family and friends.

To burn your movie to disc, do this:

1. Click  to open the Burn window.

2. Check the Burn to disc option on the Burn window.
3. Specify your burning options:

• Enter the number of copies you want to make.
• To give the disc a volume label, enter the desired label.

4. Click OK. The task begins immediately. CyberLink PowerDirector 
displays the real-time progress.

Note: The burning process may take at least a few minutes, depending on 
the length and quality of your video and your computer’s processing power. 
Be prepared for a short wait while CyberLink PowerDirector renders your 
movie!

5. When the task is completed, a window appears, displaying a 
congratulatory message. Click OK to continue.

Note: HD Content captured from HDV camcorders will be converted to 
standard definition (SD) format when burning to DVD discs. This is because 
DVD accepts only SD format. HD format will be supported on the high 
capacity HD DVD and Blu-ray discs when they become available.

Create a DVD Folder
Creating a DVD folder conveniently stores all the files that make up a 
movie in your hard drive so that it is ready for burning.

To create a DVD folder, do this:

1. Click  to open the Burn window.
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2. Check the Create a DVD folder option.

3. Click , then select the directory where you want to save 
the DVD folder.

Note: Creating a DVD folder overwrites existing data in a directory.

4. Click OK. The task begins immediately. CyberLink PowerDirector 
displays the real-time progress.

5. When the task is completed, a window appears, displaying a 
congratulatory message. Click OK to continue.

Erase a Disc
If you are using a rewritable disc, you can erase content that has data 
previously recorded on it. This allows you to reuse the same discs over 
and over without the need to continually buy new discs.

To erase a disc, do this:

1. Click  to open the Burn window.

2. Click . The Erase Disc Content window opens.

3. Insert your disc and select your drive.

• Click  to refresh the display of your drive.

• Click  to open your disc drive door.
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4. Select an erasing method.
• The Quick option erases the disc index contained on the disc.
• The Full option erases all of the content the disc contains.

5. Click Erase to start. CyberLInk PowerDirector displays the real-time 
progress of the task.
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Appendix

This chapter contains reference information to help answer questions you may 
have about the digital movie production process or about using CyberLink 
PowerDirector.

This chapter contains the following sections:

• "Hotkeys" on page 234

• "SVRT2: When Can I Use it?" on page 242

• "Video Formats & Qualities" on page 243

• "Licenses and Copyrights" on page 245
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Hotkeys
CyberLink PowerDirector allows you to employ a number of hotkeys to 
make working with video quicker and easier. These hotkeys are 
organized by function and described below.

System Hotkeys

Project Hotkeys

Hotkey Function

Alt + space bar Open the Minimize menu in the top-left corner

Alt + F4 Exit CyberLink PowerDirector

Hotkey Function

Ctrl + N Create new project

Ctrl + O Open existing project

Alt + Enter Display project properties

Ctrl + S Save project

Ctrl + Shift + S Save project as

Ctrl + Shift + W New Workspace
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Workspace Hotkeys
Hotkey Function

Tab Switch between Timeline/Storyboard

Home Go to the beginning of clip/project

End Go to the end of clip/project

Alt+1 Opens the Magic Clean function

Alt+2 Opens the Magic Motion function

Alt+3 Opens the Magic Cut function

Alt+4 Opens the Magic Fix function

Alt+5 Opens the Magic Style function

Alt+6 Opens the Magic Music function

Alt+7 Opens the Magic Movie Wizard

Ctrl + right arrow Go to next clip in the track (Clip mode)

Ctrl + left arrow Go to previous clip in the track (Clip mode)

Ctrl + C Copy

Ctrl + X Cut

Ctrl + V Paste

+ Zoom ruler In

- Zoom ruler out

Alt + L Lock all tracks except Master Video track
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Menu Hotkeys

Alt + U Unlock all tracks

Alt + C Open Preferences

Hotkey Function

Alt + F Open File menu

Alt + E Open Edit menu

Alt + V Open View menu

Alt + T Open Capture menu

Alt + P Open Playback menu

Alt + H Open Help menu

Hotkey Function
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Smart Guide Hotkeys

Main Panel Hotkeys

Hotkey Function

Ctrl + Alt + T Display Trim options

Ctrl + Alt + S Display Speed options

Ctrl + Alt + C Display Color options

Ctrl + Alt + M Display Multi Trim options

F2 Display PiP Modification Options/Title 
Designer/Effect Modification Options

Hotkey Function

F1 Help

Delete Delete selected item(s)

Ctrl + Z Undo

Ctrl + Y Redo

Shift + F12 Show Hotkey list help

Alt + F9 Switch to Capture mode

Alt + F10 Switch to Edit mode

Alt + F11 Switch to Produce mode

Alt + F12 Switch to Create Disc mode
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Library Hotkeys
Hotkey Function

F3 Open Media Room

F4 Open Effect Room

F5 Open PiP Objects Room

F6 Open Title Room

F7 Open Transition Room

F8 Open Audio Mixing Room

F9 Open Voice-Over Recording Room

F10 Open Chapter-Setting Room

F11 Open Subtitle Room

Ctrl + Enter Display media in Media Viewer

Ctrl + A Select all

Ctrl + Tab Switch between filters

Ctrl + D Detect scenes

Ctrl + Q Import media file(s)

Ctrl + W Import a media folder
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Capture Hotkeys

Voice-Over Hotkeys

Hotkey Function

Ctrl + R Record

Alt + R Start recording

Ctrl + / Stop recording

Space bar DV play/pause

Ctrl + , (comma) DV rewind

Ctrl + . (period) DV fast forward

Ctrl + / DV stop 

Alt + Y Add text captions on captured video

Hotkey Function

Ctrl + H Fade in

Ctrl + J Fade out

Ctrl + R Start recording

Ctrl + / Stop recording
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Preview Window Hotkeys
Hotkey Function

Space Play/pause

Ctrl + / Stop

, (comma) Previous unit

. (period) Next unit

Page Up Switch to Clip mode

Page Down Switch to Movie mode

Ctrl+F Fast forward

[ Mark in

] Mark out

Ctrl + T Split

Ctrl + G Goto timecode

Ctrl + E Display Precise Cut trimmer (when enabled)

Ctrl + Enter Display media in Media Viewer

Ctrl + P Takes a snapshot of content in the preview 
window

Ctrl + + (plus) Increase volume

Ctrl + - (minus) Decrease volume

Ctrl + Backspace Mute/Mute off

Ctrl + U Adjust system volume
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Title Designer Hotkeys

PiP Designer Hotkeys

Hotkey Function

Ctrl + B Set text in bold

Ctrl + I Set text in italics

Ctrl + L Left-align text

Ctrl + R Right-align text

Ctrl + E Center-align text

Ctrl + T Show/hide TV Safe lines

Ctrl + G Show/hide Gridlines

Hotkey Function

Ctrl + T Show/hide TV Safe lines

Ctrl + G Show/hide Gridlines
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SVRT2: When Can I Use it?
SVRT2 can be applied to video clips in the MPEG-1, MPEG-2, and DV-AVI 
(Type I) formats. In the following conditions, clips (or portions of clips) 
do not require rendering during production, and SVRT2 can therefore 
be applied:

• The frame rate, frame size, and file format are the same as those 
of the destination production profile.

• The bitrate is similar to that of the destination production profile.
• The TV format is the same as that of the destination production 

profile. For more information, see "Set a Video Clip’s Interlacing 
Format" on page 111.

If all of the above conditions are met, SVRT2 can be used. Any clips that 
do not meet the above criteria are fully rendered without SVRT2.

In the following conditions, clips (or portions of clips) must be rendered 
during production, and SVRT2 can therefore not be applied:

• Adding a title or transition effect
• Modifying the color of a video clip
• Audio profile does not match destination production profile
• Modifying the volume of an audio clip
• Merging two video clips (clips within 2 seconds before or after 

the merged clips will be rendered)
• Splitting a video clip (clips within 2 seconds before or after the 

split will be rendered)
• Trimming a video clip (clips within 2 seconds before or after the 

trimmed clip will be rendered)
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Video Formats & Qualities
When you burn video to disc, you must take into consideration not only 
the quality you want to use, but also the TV format of the country or 
region in which you want to watch the movie disc you burn. The section 
below offers information on both of these topics, allowing you to burn 
video discs that suit your playback capabilities.

TV Formats
The two TV formats (NTSC and PAL) have been adopted as standards by 
television broadcasters around the world. The main difference between 
the two formats is the number of frames per second they offer: 30 in 
NTSC, and 25 in PAL. This difference means that a movie recorded in 
NTSC format is unplayable by a PAL player and vice versa.

Fortunately, the question of whether to use PAL or NTSC television 
format for your disc can be reduced to the following simple question:

• In which country or region do you plan to play this disc?

Since all countries use either the NTSC or PAL format, knowing the 
location in which the disc will be played pretty much resolves this issue 
for you. By selecting the desired country or region, the television format 
is automatically set.

Note: Generally speaking, the United States, Japan, Canada, and Mexico use 
NTSC, while Germany, Great Britain, South America, Australia, and most of 
Western European and Asian countries use PAL. 
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Video Qualities
The different video quality settings (HQ, SP, and LP) available in 
CyberLink PowerDirector result in a final picture of higher or lower 
quality and a movie file of larger or smaller size. Better quality video also 
demands more from your computer and limits the video duration you 
can burn to disc. Below is a comparison of the length of video you can 
expect to be able to burn to a DVD using the different qualities:

• HQ: 60 minutes
• SP: 120 minutes
• LP: 180 minutes

For the best possible image quality in your final production, select the 
highest video quality that will allow your production to fit onto the disc 
type you are using. Your ultimate choice of video quality, however, 
should be based both on the image quality you want in your final 
production and on the processing power of your computer.

AVI Formats
Format Description

Type 1 Method of storing DV data in AVI format that was 
defined by Microsoft. This format stores data (i.e. video 
and audio) as a single AVI stream. It offers better 
compression, but is newer, and therefore compatible 
with fewer systems than Type II.

Type 2 Method of storing DV data in AVI format that was 
defined by Microsoft. This format stores data (i.e. video 
and audio) as a single video stream and 1-4 audio 
streams to store DV data. It offers wider compatibility, 
but uses an older compression than Type I. This format 
requires slightly more processing time to split the video/
audio stream while capturing
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Licenses and Copyrights
This document contains the CyberLink PowerDirector licensing and 
copyright information for Dolby Laboratories only. For the remaining 
list of applicable licensing and copyright information for CyberLink 
PowerDirector, please consult the Readme file. 

Dolby Laboratories
Manufactured under license from Dolby Laboratories. “Dolby”, and the 
double-D symbol are trademarks of Dolby Laboratories. Confidential 
unpublished works. Copyright 1992-1997 Dolby Laboratories. All rights 
reserved.
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Chapter 7:

Technical Support

This chapter contains technical support information. It includes all the 
information to find the answers you need to assist you. You may also find 
answers quickly by contacting your local distributor/dealer.

This chapter contains the following sections:

• "Before Contacting Technical Support" on page 248

• "Web Support" on page 249

• "Telephone Support" on page 249

• "Email Support" on page 250
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Before Contacting Technical 
Support

Please take advantage of one of CyberLink’s free technical support 
options: 

• consult the User Guide or the online help installed with your 
program.

• refer to the Frequently Asked Questions (FAQs) in the Support 
section of the CyberLink Web site.

http://www.cyberlink.com/multi/support/product_faq_home.jsp

The FAQs may have information and helpful hints that are more current 
than the User Guide and online help.

When contacting technical support by email or phone, please have the 
following information ready:

• registered CD-key (located on your CD case)
• the product name, version and build number, which generally 

can be found by clicking on the product name image on the 
user interface

• the version of Windows installed on your system
• hardware devices on your system (capture card, sound card, 

VGA card) and their specifications
• the wording of any warning messages that were displayed (You 

may want to write this down or take a screen capture)
• a detailed description of the problem and under what 

circumstances it occurred
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Web Support
Solutions to your problems are available 24 hours a day at no cost on 
the CyberLink web sites:

Note: You must first register as a member before using CyberLink web 
support.

CyberLink provides a wide range of web support options, including 
FAQs and a user community forum, in the following languages:

Note: A community forum and some other limited web support features are 
also available in German.

Telephone Support

In order to provide the best solution to our end-users, Voice Support is 
part of the service we provide in the following languages:

Language Web Support URL

English http://support.gocyberlink.com

Traditional 
Chinese

http://tw.cyberlink.com/chinese/cs/support/index.jsp

Simplified 
Chinese

http://cn.cyberlink.com/chinese/cs/support/index.jsp

Japanese http://jp.cyberlink.com/english/cs/support/new_site/
support_index_jpn.jsp

Language Voice Support URL

Chinese http://tw.cyberlink.com/chinese/cs/support/
voice_support.jsp
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Email Support
Email support is available in a variety of languages, including through 
the use of the technical inquiry form.

See the following list for contact information for specified languages.

English http://www.cyberlink.com/english/cs/support/
new_site/voice_support.jsp

French, 
German, 
Italian, 
Spanish

http://de.cyberlink.com/multi/program/page/
_page_display.jsp?seqno=173

Japanese http://jp.cyberlink.com/english/cs/support/new_site/
support_index_jpn.jsp

Language Web Support URL

Traditional 
Chinese

http://tw.cyberlink.com/english/cs/support/form/
index.jsp

English http://www.cyberlink.com/english/cs/support/form/
index.jsp

French, 
German, 
Italian, 
Spanish

goCyberlink@aixtema.de

Language Voice Support URL
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Index

A
add a subtitle 165
adding

audio clips to workspace 87
clips to workspace 85
color boards to workspace 87
effects to workspace 88
images to workspace 86
objects to Timeline 89
title effects to Timeline 90
transition effects to Timeline 90
video effects to Timeline 88

aliases 74
align clips in Timeline 92
analog video capture options 21
animations

in title effects 154, 156
aspect ratio

adjusting 112
setting 67

audio
adding clips to the workspace 87
capture options 23
compression bitrate 180, 183, 186
Magic Music 128

Audio Mixer 159
adding fade effect in 160

mixing audio in 159
Audio Mixing Room 71
audio types 224
Auto Create Slideshow 94
automatic batch capture 31

B
batch capturing 31

automatic 31
manual 35

batch production 208
border in PiP effects 136
Burn to disc 229
burning

configuration 227
buttons

frame style 220
layout 220
number per page 213

C
capture

automatic batch 31, 35
batch 31
from CD 45, 46
from Digital TV 41
from DV device 27
from HDV device 38
from microphone 44
from PC camera 43
from TV 40
from webcam 43
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limit options 19
media 18
mode 18
preferences 61
single scene 27

capture options 19
analog video options 21
audio 23
CD 25
deleting captured files 25
detecting scenes 26
fade-ins in 23
fade-outs in 24
limits 19
microphone 25
naming captured files 25
TV 21
webcam 24

Capture source 21
captured clip options 25
CD

capture profile setup 25
capturing from 45, 46

CD-RW
description 244

Chapter Setting Room 10, 72
Chapters

set chapter thumbnail 164
setting chapters 163

chapters
setting 163

character preset in menu text, apply-
ing 217
chroma key effect 132
clear workspace 67
clips

previewing in Media Editor 98

previewing in preview window
97

trimming 103
viewing properties in Library 75

CLNR 119
color boards, adding to the work-
space 87
confirmation preferences 59
copying

clips in workspace 91
hotkey shortcut 235

Correct Backlight 117
Correct Lighting 117
Create a DVD folder 230
create disc

mode 212
create new project file 66
creating

MPEG production profile 178,
181, 184

creating slideshows 94
customizing

MPEG production profile 178,
181, 184

customizing menu pages 213
cutting

clips in workspace 91
hotkey shortcut 235

CyberLink Noise Reduction 119

D
default

menu style 225
default durations, setting 59
deinterlacing 180
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Index
deleting
a captured file 25
files from disk 73

description 72
detecting scenes

by changing timecodes 51
in captured clips 26
in video clips 50
setting sensitivity 51

Digital TV
capturing from 41

disc utilities
erasing 230

dragging
clips in the workspace 91
to trim clips 106

duration
defaults for image files and ef-

fects 59
minimum for batch capture 37
of capture 19
of music clips in Magic Music 128
of video by quality 244
of video in Magic Cut 123
sort by in Library 72

Duration of scenes 124
DV

camcorder, capturing from 27
parameters 62
tape, writing to 196

DV Backup 29
DV-AVI

detecting scenes in 51
interlaced video in 111

DVD
interlaced video in 111

E
editing

text on disc menus 217
editing preferences 58
Effect Room, description 70
Effect track

adding effects 88
description 77

effects
previewing in Media Editor 98
previewing in preview window

97
Entropy Coding 185
erasing discs 230

F
fade-in

adding to audio clips 160
in audio capture 23
PiP effect 144

fade-out
adding to audio clips 160
in audio capture 24
PiP effect 144

file
preferences 54

file formats 16
first play 223
font in menu text, modifying 217
font in title effects, modifying 146
Frame 220
frame in PiP effects 137
full erase 231
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G
general preferences 56, 67

H
HDV

camcorder, capturing from 38
tape, writing to 200

hide a track in the Timeline 77
high quality 180, 182, 185
High Quality, video duration of 244
high speed 180, 182, 185
hotkeys 234
HQ

video duration of 244

I
images

adding to workspace 86
import a subtitle 166
importing media 16
interlacing

format, setting 111
intervals, scanning for 33
in-track audio mixing 159
introduction 1

L
Library

aliases in 74
deleting files from disk in 73
detecting scenes in 50
removing clips from 73
restricting display in 72
sorting clips in 72

lock tracks in the Timeline 77
Long Play quality

video duration of 244

M
Magic Clean

audio 119
Correct Backlight 117
Correct Lighting 117
images 116
video 117

Magic Cut 122
Magic Fix 124

images 125
videos 124

Magic Motion 121
Magic Movie Wizard 79, 115
Magic Music 128
Magic Style 127
manual batch capture 35
Maximum undo levels, setting 56
Media Editor 96

previewing effects in 98
Media Room 70
Media Viewer 96

Instant Preview 100
previewing in 98
previewing movie in 100

menu designer 214
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Index
applying character preset 217
button effects 219
editing text 217
Frame 220
modifying font 217
object effects 218
select a video effect 221
shadows 217, 218

menu page style 213
menus

add background music 222
Button Layout 220
Buttons Per Page 213
customizing 213
first play 223
Frame 220
set a clip as first play 223

microphone
capture profile setup 25
capturing from 44

mixing
in Audio Mixer 159
in-track 159

modes in PowerDirector 6
Modify 174
modifying disc menu

Button Layout 220
Buttons Per Page 213
editing text 217

modifying effects
title 144
video 129

motion
adding to image clip 121
of PiP effects, modifying 138

Motion of PiP effects
add a pre-defined motion 139

customize motion 141
movie

previewing in Media Viewer 100
previewing in preview window

99
movie-making process 7
moving clips in workspace 91
MPEG

production profiles 178, 181, 184
Music track

adding clips 87
description 77

muting
audio tracks 108
entire track 108

N
naming captured files 25
narration, recording 160
new

project file 66
workspace 67

noise removal 180, 182
NTSC

countries that use 243
frame rate 243

O
Objects

modifying 130
objects

adding to Timeline 89
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Objects, description 71
OEM versions 3
open project file 67
Original version window 115
Output version window 115

P
PAL

countries that use 243
frame rate 243

pan an image 121
pasting clips in workspace 91
PC camera, capturing from 43
photo

Magic Fix 124
PhotoNow! 111
PiP Designer 130
PiP effect

modifying 130
PiP effects

adding frame 137
customize motion 141
customize rotation 139
modifying border 136
modifying motion 138
modifying position 131
modifying size 131
pre-defined motion 139
shadows 134
transparency 138

PiP track
adding color boards 87
adding images 86
adding objects 89
adding video 86

description 77
position of PiP effects, modifying 131
PowerDirector

interface 5
modes 6
versions 3

preferences
capture 61
confirmation 59
editing 58
file 54
general 56, 67
produce 63

pre-production
ready to burn 2

Preview Window 95
preview window

Instant Preview 100
previewing clips in 97
previewing effects in 97
previewing movie in 99
resolutions 99, 101

previewing
clips in preview window 97
effects in Media Editor 98
effects in preview window 97
in Media Viewer 98
movie in Media Viewer 100
movie in preview window 99

Produce
streaming video file 193
upload to MediaMax 206
upload to YouTube 203
video file 187
write back to DV tape 196
write back to HDV tape 200

produce
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Index
multiple projects 208
produce mode 171
produce preferences 63
producing

before 172
your movie 169

profiles
creating and modifying 174
QuickTime 192

program interface 5
project file

create 66
open 67
properties 67
save 66

project file, description 6
properties

of clips in Library 75
project file 67

Q
quality vs speed of video 180, 182,
185
quick erase 231
QuickScan 33
QuickTime

profiles 192

R
recording a voice-over 160
removing

clips from Library 73

clips from workspace 93
renaming clips 74
resizing the ruler 78
resolution 182, 185
restore to original clip name 74
restoring volume levels in audio
tracks 160
restricting display of clips in Library
72
ripping CD tracks 45, 46
Rotation of PiP effects

customize rotation 139
ruler, resizing 78

S
save project file 66
scanning for intervals 33
scene detection 50
Scenes with moving objects 124
Scenes with people speaking 124
Scenes with zoom/pan 124
select clips in the workspace 91
set button effects 219
Set chapter thumbnail 164
Set chapters 163
set object effects 218
setting

chapters 163
default durations 59
Maximum undo levels 56

shadows
in menu text 217, 218
in PiP effects 134
in title effects 150, 152

size
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limit for captures 19
of PiP effects, modifying 131

Slideshow Designer 94
Slideshows

auto create 94
slow-motion, adding to video 108
smoothing 179, 182
snapshot

default destination 55
default filename 55
of video clip 49

sorting clips in the Library 72
Source video, audio 21
SP quality

video duration of 244
speed

of video clips 108
vs. quality of video 180, 182, 185

splitting clips 102
Standard Play quality

video duration of 244
streaming

profile, QuickTime 192
style

menu page 213
subtitle

add 165
import 166
sync 167

Subtitle Room 72
supported file formats 16
SVCD

interlaced video in 111
SVRT

using in disc production 188
viewing in project 170

syncing subtitles 167

system requirements 12

T
tape, writing to 196, 200
time limit for captures 19
Timeline

adding objects 89
adding title effects 90
adding transition effects 90
adding video effects 88
align clips 92
hide tracks 77
lock tracks 77
unlock tracks 77
view 76

title effects
adding to Timeline 90
animations 154, 156
modifying font 146
shadows 150, 152

Title Room 71
Title track

adding titles 90
description 77

titles to workspace 88
tracks

descriptions 77
hide 77
lock 77
unlock 77

transition effects
adding random 90
adding to Timeline 90

Transition Room 71
transitions to workspace 88
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Index
transparency of PiP effects 138
trimming

audio & video clips 103
dragging an edge 106
video or audio 103

TV
capture options 21
capturing from 40

U
UI, default 5
unlock a track in the Timeline 77
Update SVRT Info 170
Upload video

MediaMax 206
YouTube 203

V
versions of PowerDirector 3
video

adding to workspace 86
Magic Fix 124
Magic Style 127
overlay 61
size 193

video clips
detecting scenes in 50
snapshot of 49

video compression rate 179, 182, 185
video effects

add to entire clip 89
adding to Timeline 88

modifying 129
video qualities 224

hint on selecting 244
video duration of 244

video size 179, 193
video thumbnail 225
Video track

adding color boards 87
adding images 86
adding transitions 90
adding video 86
description 77

viewing
clip properties 75
project properties 67
SVRT information in project 170

Voice track
adding audio 87
description 77

voice-over recording 160
Room 160

Voice-Over Recording Room 71
volume

changing in Audio Mixer 159
changing in-track 159

volume keys
adding to an audio track 159

W
webcam

capturing from 43
video capture options 24

where to begin reading 7
White Balance 117, 118
White Calibration 117, 119
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workspace
adding clips to 85
adding effects to 88
adding titles to 88
adding transitions to 88
new 67
Timeline view 76

write back to
DV tape 196
HDV tape 200

write to DV tape 196
write to HDV tape 200

Z
zoom an image 121
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